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P R E FA C EP R E FA C E
IINCON-ME3 is a new generation CNC controller of INTEK for CNC 
milling. 

INCON-ME3 adopts the new generation electronic technology, so that it 
is so fine in dimension and electronic layout. We use high density IC to 
reduce a lot of electronic parts of  INCON-ME3, and make INCON-ME3 
have high steady feature.

INCON-ME3 is an economical  controller, but it has complete functions 
for a normal milling. It has complete operation board and the interface 
suitable for users. For example: pull down menu, dialog box, the 
sensitive help, compelte cutting option,  manual  feed program operation, 
tool compensation, linear interpolation, arc interpolation, cancycles, FTP 
file transfer, and USB.

Use〝Help→List System Parameters...〞item on the pull down menu 
and print system parameter when you first operate a CNC milling. The 
list   is the most important backup information for maintenance. 

INTEK will take the responsibility for maintenance of the INCON-
ME3 controller during warranty time. Because machine is not INTEK 
product, do'nt warrant the precision of cutting by the CNC milling with 
INCON-ME3. 

INTEK provides limited technology support in a business contract. But 
all users can log in the message board of website: support.intek.com.tw 
and ask your questions, INTEK will answer you on line. 

All rights are reserved by INTEK Technology Co., Ltd..
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  Chapter 1 Quick Guide 

Chapter 1  Quick Guide

1.1    Starting and Home
The main screen will display when power applies to ME3 system if ME3 has no error and 
alarm.

Figure 1-1  The main screen of  INCON-ME3

The screen changes as below figure when switch to the Home manual mode by the manual 
button on 2nd operating panel, GMPU.
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Figure 1-2  The screen of the home manual mode

Press the Home button to make axes Home. For safety, please make Z axis Home first, and 
then X or Y axis Home. Before Home, make sure the relative position between tool and parts 
won't occur collision. Press the Emergency button on the 2nd panel when occurring danger.

The machine comes to a machine position which is the same as the one when power off  last 
after Home process.  

Press the Manual Off button on the 2nd panel to leave the manual mode, and operate other 
functions further.
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  Chapter 1 Quick Guide 

1.2   Edit the first program 
Press the F2 function key ,then F key, and select the item〝NEW〞on the File pull down 
menu after leaving the Home mode.

〝F2→F→NEW〞means the operating step above in this user manual. The other operating 
steps of the pull down menu show through the same mode.

Figure 1-3  Open a new file through the File pull down menu
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The empty editor screen is showing on the left half of main screen then. 
And the headline〝<  UNTITLED  >〞is showing on the top of the editor.

The symbol〝<      >〞means that the editor can edit programs. The figure shows below.

Figure 1-4  The new empty program in the editor

Input the following CNC program in the editor directly.

G90 G0 XY Z10.
G95
M3 S1000
G84 Z-10. F0.5 P2.
G0. X10.
M05
G94
M30

4



  Chapter 1 Quick Guide 

Press the Esc key to leave the Edit mode after inputing CNC program. Then a dialog box 
pops up on the screen and ask users〝Save untitled file?〞. 

Figure 1-5   A dialog box: Save untitled file or not.

Please press the Y key and then pop up the other dialog box below to input program file name.

 
Figure 1-6    A dialog box: input file name
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The first CNC program finishes after inputing file name〝0001〞, and then the figure shows 
below.

Figure 1-7   The program can execute in the Ready mode.

The CNC program name is〝[ 0001 ]〞, and the symbol 〝[       ]〞means the editor has 
been ready to run CNC program.

Press the F3 key to enable editor  to modify the CNC program and then the CNC program 
title becomes〝< 0001 >〞 again.
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1.3   Set Program Position
The machine position gets absolute position after Home process. MX, MY and MZ in the 
bottom screen are current machine position.
Editing the CNC program refers to part original drawing. We call it program position, PX, PY 
and PZ , shows on left bottom of screen. 

We  can execute cutting according to this CNC  program correctly after adjusting the offsets 
of  machine position and program position.

The offsets of  machine position and program position are relative to the two following things:

 The fix position of a part.
 The fix position of a tool for cutting.

Fix a part and a tool first. Then switch the mode to Manual. Use Jog and Signal Step to shift 
the tool to PX、PY、PZ=0 desired〔the location is the origin of X, Y and Z axis〕.

Figure 1-8   A diagram of milling
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Press ALT+X〔Y or Z〕and input the offset into Coordinate Offsets automatically. Press 
the Enter key to finish the adjustment of  X〔Y or Z〕 axis〔Press the ESC key when 
leaving the dialog box.〕

Figure 1-9  Press ALT+X〔Y or Z〕and input the offset into Coordinate Offsets automatically. 

8
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By the same way, measure a part by a vernier caliper. The tool is located at PX=18.2 when we 
get the value 18.2 mm. We press Shift+X and then pop up a dialog box to input the program 
position.  

Figure 1-10  Press Shift+X and pop up a dialog box to input the program position 

Input the value 18.2 and then press the Enter key. The controller will fill the offset an user 
inputs in Coordinate Offsets automatically. Make Sure the value is correct and press the 
Enter key to input the Offset of X axis in the controller.
That's all to finish the adjustment of X axis program position.〔〔Press the ESC key when 
leaving the dialog box.〕
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1.4   Run Program
We may cut the first work piece after input CNC program and adjust the program position.

The use of  millings may be dangerous. We must know the safety so well that we don't crash 
the parts of the millings to hurt our bodies.

The program runs for the first time, and so it is possible something happens to the program or 
the position. We can do that then:

 Press the function F5 key to enable Single Step.
 Switch the percentage of FV, GV and spindle feed rate override to the lower one.

When everything is ready, press Cycle Start to run program.

As soon as a block ran the program paused by Single Step. Then we may check if the running 
program is what we expect, the spindle works or not and tool position reach where we expect, 
for example. Press the F10 key to stop running program and modify program, or adjust the 
program position when something happens.

Cancel Single Step after every step running correctly.  And switch the percentage of FV, GV 
and spindle feed rate override to the normal one and start to work.

10
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Chapter 2  Screen and 
Operation

2.1  Keyboard
The ME3 controller can work in coordination with normal monitors and keyboards on the 
market, or optional GKYU〔one 8 inch monitor and one keyboard 〕.

Figure 2-1 One monitor and keyboard

There are 10 function keys〔F1~F10〕below the monitor, and 56 keys on the keyboard:

26 character keys : A to Z.
12 digital keys : 0 to 9, 〝.〞and〝-〞.
4 arrow keys :  up〔↑〕, down〔↓〕, left〔←〕 and right 〔→〕arrows
7 editor group keys : Ins, Del, Home, End, PgUp, PgDn and BS
3 auxiliary keys : Shift, Ctrl and Alt
4 else keys:  Esc, Tab, Space and Enter
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Note: Use the alcohol or cleaning naphtha to clean the panel. Don’t use the strong solvent 
such as banana oil or toluene!

The meaning of some abbreviation is as below:

Ins  : Insert Del : Delete PgUp : Page up 
PgDn  : Page down Ctrl : Control Alt : Alter 
Esc  : Escape Tab  : Tabulate BS : Back Space 

3 auxiliary keys can't be used individually, they must be used with other keys. For example, 
〝Shift+ A〞 means press and hold the Shift key first and the A key next.〝Ctrl+F1〞and 
〝Alt+F3〞are both the same usage.

A Dialog box is used to set data to adjust system parameters. When modify or input data in a 
dialog box, press the following keys:

Alt + highlight character : select a setting item
Tab : switch a setting item forward
Shift + Tab : switch a setting item  backward
Esc : leave
Enter : save the setting

With a Check List, [     ]∕[ √ ], press Up or Down arrow key to switch to the desired sub-
item, and then press Space key to toggle it.
With a Radio Button, (    ) ∕ ( ● ), press Up or Down arrow key to select the desired sub-
item.

2.2   Statusline and Hot key listing 
At any time, there is a statusline on the bottom of the screen, which consists of some hot keys 
which provide easy and quick access to system functions.
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Case 1: program window while no program 
is running   

Case 2: program window while program is 
running  

F1：Help
F2：Pull down menu
F3：Switch editor to EDIT mode
F5：Single Step
F6：Switch to trace window
F7：MDI〔Manual Direct Input〕
F8：Hold 
F9：Run〔program execution〕
F10：Emergency stop

F1：Help
F2：Pull down menu
F5：Single Step
F6：Switch to trace window
F7：MDI〔Manual Direct Input〕
F8：Hold 
F9：Run〔program execution〕
F10：Emergency stop

Case 3:program window when editor is in 
EDIT mode

Case 4: MDI -- Manual Direct Input

F1：Help
F2：Pull down menu
F3：Save 
F5：Copy
F6：Clear
F7：Paste
F8：Cut
Esc：Back to Ready mode

F1：Help
F2：Pull down menu
F8：Hold
F9：MDI continue
F10：Emergency stop
Esc：Stop MDI only

Other keys：

Alt+F8：Switch between system state 
window ∕position state window 
and I∕O state window.

Alt+F1 ： Help for code listing
Shift+F1： Help for topic listing
Ctrl+F1： Back to previous page

13
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Pull down menu：

F2→F：File
F2→E：Edit
F2→R：Run program
F2→P：Parameter setting
F2→H：Help

Summary of the operation keys:

Operation Key Function Operation Key Function

→ Shift cursor right PgUp Page up

← Shift cursor left PgDn Page down

↑ Shift cursor up BS Delete a character forward

↓ Shift cursor down Delete Delete a character

Ctrl + → Shift right a word Ctrl + T Delete a word

Ctrl + ← Shift left a word Ctrl + Y Delete a line

Shift +↑↓→← Block an area Ctrl + Delete Delete a block

Home Shift cursor to line start Ins Insert Mode  

End Shift cursor to line end Ent New Line

Ctrl + Home Shift cursor to page top

Ctrl + End Shift cursor to page bottom

2.3    Screen display
There are six windows of information displayed on the ME3 screen:

1. Program Window
2. System State Window

14
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3. I∕O State Window
4. Position State Window
5. Trace Window 
6. MDI Edit Window

Figure 2-2  The main screen of  ME3

Upon turning on the power, the main screen displays. It consists of  Pull down menu, 
Program Window, System State Window, Position State Window, I∕O State Window 
and MDI Edit Window, such as the Figure 2-2.

There are 5 functions of  Pull Down Menu on the top of the screen : 〝File〞, 〝Edit〞, 
〝Run〞,  〝Parameter〞 and 〝Help〞. There are 10 function keys on the bottom of the 
screen, F1 to F10. When you press the key F7, the screen will pop up a MDI Edit Window. 
Press Esc to leave MDI Edit Window.
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2.3.1    Program Window

Program window contains current program listing.
In this window you can:

 enter menu item〝File→new〞to create another CNC program.
 enter menu item〝File→open〞to open another existed CNC program.

We explain the variations of Program Window on every conditions, as the following figures.

Before new program doesn't save, the top of  Program Window shows 〝<  UNTITLED >〞.

Figure 2-3   A new CNC program

The top of  Program Window shows〝[  filename  ]〞means Editor is disable and ready to 
run a program. The program now can run but can't edit. When you want to edit it, press F3 to 
switch the mode to edit.
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Figure 2-4   “[  filename  ]” means Editor is disable and ready to run program.

The top of  Program Window shows 〝<  filename  >〞means Editor can edit the current 
program. Press Esc to finish editing and switch the mode to run program.

Figure 2-5   “<  filename  >” means Editor can edit the program.
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The top of  Program Window shows 〝<  filename * >〞means the program has modified 
but does not save yet.

Figure 2-6   “<  filename*  >” means the program modified and does not save.

The filename of the Program Window shows the figure〝  〞 means current program 
opens, edits or modifies in an USB device.

Figure 2-7   “  “  means current program opens, edits or modifies in an USB device.
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2.3.2    Position State Window

Position state window displays 4 positions for user to operate controller. It is located on the 
bottom of  the screen and update at once.

PX/PY/PZ: Program position for all axes
DX/DY/DZ:  Distance to go for all axes

MX/MY/MZ: Machine position for all axes
RX/RY/RZ: Relative position for all axes 

Figure 2-8   Position state window 

1. Program position keeps a registration of system motion movement in unit of  FU〔Feed 
unit〕.

2. Distance to go for all axes shows the remain distance to go of current executing command 
in unit of  FU〔Feed unit〕.

3. Machine position keeps registration of the real pulses generated in unit of  FU〔Feed 
unit〕.
Machine position keeps unchanged as system is in Machine Lock State, but Program 
position keeps on recording motion movement.
Position soft limit use Machine position to compare with soft limit data.
Machine position is reset to machine position preset as Home Return completes.

4. Relative Position shows the distance traveled after last menu item Relative Position 
Reset has been executed.

Note:

1. The least significant digit of position data of INCON-ME3 system is equal to 1 FU〔Feed 
unit〕. This FU is the basic unit of distance, 0.001 mm.

2. During tool length compensation, the Z value in program position will be the no-
compensated position. Whereas in tool radius compensation, the X / Y value in program 
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position will be the compensated position. 

2.3.3   System State Window

The System State Windows is located on the right top of the screen, and it displays current 
system states.

Figure 2-9    System State Windows 

The bottom of the  System State Window lists some toggled state for execution control. If 
the state is blocked in white reverse, this state is active. The meaning of these states lists as 
the  following:

PP     ：Displays current running program line
TP     ：task number of program execution line
RT    ： Displays time for running the program
F       ：F_ value of the program
S       ：Spindle speed setting
T       ：Tool selection
L       ：Loop count
D       ：tool radius compensation number
H      ：tool length compensation number
FV    ：Feedrate override
GV   ：G00 speed override
JV    ：Jog speed override

RUN：The program is running
HLD：program hold
SST：Single Step
SIM：Simulate
/SK：Block Skip
INP：in position
G00：run G01/G02/G03/G33 
G40：run G40/G41/G42 
G49：run G43/G49 
G54：run G54~G59 
G17：run G17/G18/G19 
G60：run G60/G61 
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2.3.4    I∕O State Window

The I∕O State Window is under the System State Window. It displays the current situation of 
the machine.

The first two lines display fixed items: manual and spindle. The others  display items 
depending on PLC.

Manual

 

Upon using〝Manual〞of  GMPU〔〝Manual〞includes Single Step, Jog, Hand Wheel 
and Home〕, the first line highlights with yellow color. The last item of this line means 
〝STEP〞. 

Under the Manual mode, press Alt+X〔Y, Z〕or Shift+X〔Y, Z〕to pop up a Coordinate 
Offsets dialog box to set parameters for geometry offset. Don't have to select this menu item: 
Parameter→Coordinate Offsets .... to set parameters again.

Figure 2-10 Manual display
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Spindle

“SPINDLE” displays direction, override percentage and speed of spindle.

Figure 2-11 Spindle display

2.3.5  Trace Window〔F6〕

When a program simulates or runs, press F6 and then the Trace Window is located on the 
right bottom of the screen.

Figure 2-12  the Trace Window is located on the right bottom of the screen.
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There are some keys can be used to configure the graphic environment:

● Arrow keys: Move the graphics up∕down∕left∕right
● Ctrl+I∕Ctrl+O: Zoom in∕out the X and Z axis of graphics
● Ctrl+Home: To center the graphic cursor
● Ctrl+Del: Clear the graphic view
● Esc : Leave the graphic mode.

2.4    MDI Edit Window
This is a dialog box for user to enter one line of  command.

Figure 2-13  A MDI dialog box

You can also use Down arrow key to recall the commands that was entered previously.
After making sure that the command line is correct, press Enter to execute. Esc to abort MDI 
motion, F10 to stop the whole system〔including the program that is running〕.

Warning : Press Enter key will execute the command in the input line immediately. To make 
sure all machine limits, before pressing Enter key!

2.5    Manual Control
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The manual control is conjunctive with machine panel, your machine marker shell proved 
more detail of operation.
The following operation is conjunctive with GMPU. 
There are 4 modes of Manual Control:

〝INC〞: Increment
〝JOG〞:Jog
〝WHL〞:Hand Wheel
〝HOM〞:Home Return

Four adjust override and  their ranges are list as below:
  

Set Jog speed override: Total 16 steps, in 10% interval. 〔0%~150%〕

Set G00 speed override: Total 16 steps, in 10% interval. 〔0%~150%〕

Set Feedrate Override: Total 16 steps, in 10% interval. 〔0%~150%〕

Set spindle Override: Total 11 steps, in 10% interval. 〔50%~150%〕

〝INC〞: Increment

Press the specified button to switch the mode to INC. Then moves the axis by the button +X, 
-X,+Z or -Z. Pressing the rotary encoder can select the INC strided distance.〔There are 4 
selections of strided distance, 1, 10, 100 and 1000.〕

〝Jog 〞: jog

Press the specified button to switch the mode to JOG. Then moves the axis by the button +X, 
-X,+Z or -Z.  Adjust jog speed override by rotating the rotary encoder. 

Note: JOG speed is set by〝Machine parameter→Axis→X/Y/Z axis→Jog speed〞.

〝WHL〞: Hand Wheel

Press the specified button to switch the mode to WHL. The default PLC setting is using 
rotary encoders to operate Hand Wheel function. The machine can be set in single hand 
wheel or multiaxial hand wheel mode by〝Machine parameter→Motion and 
Speed→[    ]Multi hand wheel〞.Pressing the rotary encoder can select the Hand Wheel 
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strided distance.〔There are 3 selections of strided distance, 1, 10 and 100.〕

〝HOM〞:Home Return

Press the specified button to switch the mode to Home.

The origin of Home is set by machine makers, users execute Home can return automatically.
For safety, users had better Home Return with Z axis first, and then do with X or Y axis.
〔Home sequence can be set by〝machine parameter→Motion and Speed→Home 
sequence〞.〕Because the motion of Home Return is automatic, press the Emergency Stop 
button to stop working when emergency occurs.

2.6   Manual feed forward or 
backward
When a CNC program is running, we can press F8 key or Feed-hold button to pause the CNC 
program. At this situation, users can enable the manual feed function. 

Under WHL mode, clockwise manual feed operation will keep the interpolation and CNC 
program running forward with manual feed speed; counter-clockwise manual feed operation 
will keep the interpolation and CNC program running backward with manual feed speed . In 

Under Inc or Jog mode, the manual feed forward or backward still enables. Therefore we can 
use these functions to check the tool path by manual feed operation.
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Figure 2-14   Manual feed forward or backward

Doing manual feed backward, it will reverse the path programmed. Meeting the non-motion 
command, such as M-code or status-change G-code, the manual feed backward will stop 
working and don't back anymore .

Three ways enable the manual feed function: 

1. Press the specified button to switch the mode to Manual and then press 〝Cycle 
Start〞bottom. The program will be held in to pause state and ready to do manual feed 
operation.

2. Press F8 key or 〝Feed-hold〞button during program running, and enable Manual mode 
by GMPU〔2nd operation panel〕. Then it is ready to do manual feed operation.

3. Insert〝M100/M101〞code in the program. When these two codes being executed, the 
program will pause like M00/M01. Then enable manual feed operation.

Note:

1. M00/M01 stops running a program and then allow to do the normal Manual operation 
instead of manual feed operation.

2. The value of 〝Machine parameter→Motion and Speed→Feed acceleration〞is 
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negative denotes the manual feed operation doesn't works, otherwise the manual feed 
operation dose. The Feed acceleration is positive or negative depending on machine 
features. Generally, the Feed acceleration has been set by your machine maker.

2.7    File Transmission
INCON-ME3 is a FTP server, we explain how to upload and download files between a 
controller and a personal computer in this section.

You have to get a FTP software, which  is  free software from Internet, bought form software 
company ,or provided by INTEK.

Run the FTP software designed by INTEK, the following page displays on PC screen. The 
procedure of FTP is list as below:

1. Input the IP address.
2. Input the user name and password. The built-in user name is〝INTEK〞and password 

can be none or other characters.
3. Press Connect button, and then log in the FTP controller.
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Figure 2-15  the main screen of FTP 

At the time of connection success, we find out files of ME3 on the right side of  the main 
screen. We can upload and download files. The operation is like using FTP software generally.

Figure 2-16  the main screen at the time of connection success
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2.8    Alarm listing and trouble 
shooting
When errors happening, the screen pops up an error message dialog box . These error 
messages are listing in groups as follows:

2.8.1  Fatal system error

No. Alarm ∕ error message Trouble shooting

System check sum error
Power off and turn on again after 10 seconds later. If it still 

doesn’t work, call for service.

501 PLC Alarm
PLC detected I∕O process error, follow the instruction of the 

message. If it still doesn’t work, please call for service.

514

515

516

517

 X position control loop fail

Y position control loop fail

Z position control loop fail 

A position control loop fail

Servo driver or encoder error. Power off and turn on again after 

10 seconds later. After restarting the system, it still doesn’t 

work, please call for service.

518 PLC Alarm: EMG input is on
PLC detected the EMG button being pushed. Release EMG 

button and use manual operation to move the tool to safe area.

519

520 

521

522

X axis not in-position time out

Y axis not in-position time out

Z axis not in-position time out

A axis not in-position time out

X/Y/Z/A Servo lagged too large to follow the commanded 

speed. There are many reasons. Refer the above-mention 

methods to solve the problem.

531 Bad machine parameter data, please reload it
Due to abnormal shutdown. 

(Call for service, and reload the machine parameter) 

546 Spindle close loop control fail as doing rigid tapping

Check the circuit of spindle, motor or encoder. And then check 

whether spindle rotates smoothly. If it still doesn’t work, please 

call for service.
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2.8.2    Motion control alarm

No. Alarm ∕ error message Trouble shooting
506 

507

508

509 

510 

511

512

513

Soft limit on X positive side tripped

Soft limit on X negative side tripped

Soft limit on Y positive side tripped

Soft limit on Y negative side tripped

Soft limit on Z positive side tripped

Soft limit on Z negative side tripped

Soft limit on A positive side tripped

Soft limit on A negative side tripped

Software limit tripped.

Check the limit travel data in related machine data. 

Or check the travel distance in the CNC program. 

523 

524

525

526 

527 

528

529

530

Limit on X positive side tripped

Limit on X negative side tripped

Limit on Y positive side tripped

Limit on Y negative side tripped

Limit on Z positive side tripped

Limit on Z negative side tripped

Limit on A positive side tripped

Limit on A negative side tripped

Limit switch tripped.

Check the travel distance in the CNC program or 

check the limit switch.

542

543

544

545

X axis over travel limit, position is lost, please do home after 

recover

Y axis over travel limit, position is lost, please do home after 

recover

Z axis over travel limit, position is lost, please do home after 

recover

A axis over travel limit, position is lost, please do home after 

recover

PLC detected over travel fatal error, and disable the 

servo driver of the relative axis. Therefore the 

position is lost and must do home operation after 

recovery the error.
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2.8.3   Other fatal errors

No. Alarm ∕ error message Trouble shooting
505 Internal error Illegal G code at N

532 Do homing first Never do home return operation, therefore program 

cannot fine the zero point.

533

534

Probe detected outside of detect zone

Probe not detect

Check the detect zone again and modify the G37 

command

538

539

540

Please home Z axis before this home action 

Please home Y axis before this home action

Please home X axis before this home action

Home Z before this

Home Y before this

Home X before this

Divided by zero error

Exception error

System process fatal error. If possible, please offer the 

program for INTEK technology to simulate the error 

condition and correct the error. Thanks for offering.

2.8.4   General errors

No. Alarm ∕ error message Trouble shooting
001 Incorrect command line Refer to G code list 

002

003

004

The number of nested M95 exceeds 8

The number of nested M97 exceeds 8

The number of nested M98 exceeds 8

The layer number of subroutine nest call can up to 8 

layers maximum.

005 Incorrect M95 command format M codes error

006 M97 needs a subprogram number to execute M97 has no subprogram number

007 M98 needs a subprogram file name to execute M98 has no a subprogram file name

008 Can not execute M99, since no subprogram has been 

called

No main program and execute subprogram directly

009 Can not change working plane here Can not change working plane here in tool radius 

compensation

010 No homing has been done Do home operation first

011 No compensation is allowed No compensation is allowed in MDI dialog box MDI  
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No. Alarm ∕ error message Trouble shooting
012 Can not execute G29, since no G28 or G30 has been 

done

There must be a middle point specified by G28 or G30 

before G29

014 Radius compensation is on already Don’t given G41/42 again.

015 No G51 is allowed, since G68 is on G51 can not execute before cancel G68

016 No G50 is allowed, since G69 is not done yet When G68 is in G51，must use G69 cancel G68 

command first  and  then use G50 cancel G51 command

017 Incorrect G52, at least one of X, Y, Z, OR A must 

presents 

Illegal G code

018 Must be G01 to do chamfering or corner rounding

019

020

Incorrect mirror axis

Working plane has to be specified

Mirror axis is relative to  working plane specified

021 Another radius compensation is on Don’t give G41/42 again under radius compensation

022 Length compensation is on already Don't give G43 again under length compensation

023

024

The command code to approach radius compensation 

must be G00 or G01

The command code to depart from radius compensation 

must be G00 or G01

027

028

Third axis motion is not allowed when radius 

compensation is on or in chamfering/corner rounding 

session

Fourth axis motion is not allowed when radius 

compensation is on or in chamfering/corner rounding 

session

Radius compensation and chamfering/corner rounding 

are only performed on dedicated plane 

029 No full circle is allowed following G02/G03 command 

during radius compensation

030 Interpolation command is not allowed following a full 

circle when radius compensation is on

031 Illegal MDI code Only some legal code can be accepted in MDI

032 Illegal H Code H range: 1~128

033

034

Illegal T Code

Illegal M Code

T range: 1~128

M range: 0~99 

035 Illegal M Code Refer to G code list

036 No D code allowed here, since tool radius compensation Don't change tool radius compensation under G41/G42
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No. Alarm ∕ error message Trouble shooting
is on

038 Incorrect can cycle command, need a reference position

039 Cancycle cancellation is not allowed since cancycle is 

not done yet

Press F10 to stop Cancycle

040 Radius compensation is on, no motion code is allowed

041 G33 is not allowed in G94 mode G33 must be performed in G95 mode.

042 Drilling depth is missing

043 Reference distance is missing for G87

044 G87 has to be in G98 mode

045 No radius compensation is allowed for can cycles

046 Can cycle or pocket is on, no motion command in MDI is 

allowed 

047 Scaling is on already Don’t repeat G51 before cancel it.

048 Rotation is on already Don’t repeat G68 before cancel it.

049 Out of memory Exception error

(If possible, please offer the program for INTEK 

technology to simulate the error condition and correct the 

error. Thanks for offering)

050 G53 has to be run in absolute mode

051 Tool length measurement is not allowed during fast run 

stage of run from middle

Fast run doesn’t simulate G37 command. 

G37 should be under really run the tool length 

measurement.

052 Tool number has to be assigned before carrying out G37 Must specify the D value before G37

053 Circular pocket radius has to be specified

054 Rectangular pocket length and width have to be specified

055 In feed increment is needed for pocket command

056 Pocket center is not defined

057 Pocket cutting orientation is not specified

058 G88 is not allowed during fast run stage of run from 

middle

Fast run doesn’t simulate the manual operation in G88.

059 Pocket total depth is smaller than its fine feed depth The fine feed depth must be reasonable.

060 Pocket total dimension is smaller than its fine feed width The fine feed width must be reasonable.

061 G37 is not allowed in case of machine lock or spindle Unlock the machine and spindle before execution G37 
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No. Alarm ∕ error message Trouble shooting
lock command.

062 No G92 when either tool compensation is on G92 is not permitted in G42/43/44 mode.

063 Rigid tapping command without S code Refer to chapter 4

064 Rigid tapping command with too large an S Code The S value should be reasonable.

065 Rigid tapping is disabled since max rigid tapping spindle 

speed is 0

The S value should be reasonable.

066 Illegal D Code D range: 1~128

067 Spindle axis feed rate is missing" for pocket command Specify the I_ item in G70/71 command.

068 Tool radius can not be zero" for pocket command Set radius in tool table and specify the tool table number 

previously.

069 Corner rounding radius is too big The corner rounding radius should be reasonable

078 Number is too large The given value larger than 9 digits

081 Tool radius compensation for next two commands will 

over cut

Tool radius compensation don’t suit for too many 

continual short lines cutting, short than tool radius

082 Lack of next section for tool compensation See the note of tool compensation

083 Incorrect sign for some command items Check the format of the command

084 Illegal can cycle code Check the format of can cycle

085 Incorrect working plane with respect to spindle aligning 

axis

Refer to  pocket or dowel command

086 OSS shift is necessary for G76 or G87 Refer to the command of G76 or G87

087 Not a close contour Refer to the command of G70.1x

088 Contour compensation type is necessary Refer to the command of G70.1x

089 Contour approaching radius is necessary Refer to the command of G70.1x

090 Contour subroutine is missing Refer to the command of G70.1x

091 Illegal contour command code Refer to the command of G70.1x

092 3rd axis motion is not allowed for contour Refer to the command of G70.1x

093 Too many commands for contour Refer to the command of G70.1x

094 Incorrect compensation(G41/G42) for contour pocket Refer to the command of G70.1x

095 4th axis motion is not allowed when direction tracking is 

on

Refer to the command of G70.1x

096 4th axis has to be on for direction tracking Refer to the command of G70.1x

097 Incorrect object pattern command line Refer to the command of G70.1x

098 Object count has to be greater than zero Refer to the command of G70.1x
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No. Alarm ∕ error message Trouble shooting
099 Center position is needed for arc object pattern Refer to the command of G70.1x

100 Sections in contour pocket intersects Refer to the command of G70.1x

101 while system is running and not held by M00/M01, only 

M,S,T codes are allowed for MDI

Refer to the chapter of panel operation → MDI section

102 A subroutine/subprogram has to end with an M99 Follow the message

103 Hard Disk Error Check hard disk

104 Incorrect command line for general data setting

105 Data setting mode is on

2.9   Maintenance notice
1. The quality of local electrical power isn't steady, it has to add a power regulator to keep 

the electrical variation under 10%.
2. To keep the controller in better work condition, it had better to keep the room temperature 

under 40 .℃
3. Clean the filter of  the electric cabin weekly or  monthly to keep the controller with good 

ventilation.  
4. Use the alcohol or cleaning naphtha to clean the key pad and the acrylic board. Don’t use 

the strong solvent!
5. Try your best to let all sorts of fluids and ashes not to touch on printed circuit 

 boards of controller .To avoid weak electronic components or short circuit.
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Chapter 3  Pull Down 
Menu
INCON-ME3 provides a convenient window based screen for you to access all functions of 
this system. There are 5 submenus listed on the upper edge of screen. They are File, Edit, 
Run, Parameters, and Help.

Figure 3-1  Pull Down Menu on the upper edge of screen

Users can pull down each one of them by pressing F2 and then the highlighted character of 
that submenu or the arrow keys.

For Example: pressing F2→E pulls down the Edit submenu.
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Then you can use arrow keys as follow:

Up〔↑〕∕Down 〔↓〕 arrow key : highlight one of the menu item.
Left〔←〕∕Right〔→〕 arrow key : switch to another submenu.

The selected menu item will be highlighted. Pressing Enter key can be entered to activate the 
menu item. At this time, there are usually 2 buttons on a dialog box popped up, OK or 
Cancel. Pressing Enter key means enter and save the setting, but Pressing Esc key means 
cancel the setting and leave the dialog box.

The dialog box of  Parameter setting uses the Enter key to save the setting and dialog box 
keeps the screen for users to check their settings until press Esc key to leave it.

You can also use Hot keys shown in the status line on the lower edge of the screen to activate 
the desired functions immediately. For example: Press F6 for graphic display.

3.1    File〔F2→F〕
The File submenu provides user to manage the CNC programs. 

Figure 3-2 The File submenu

Description

N：Initiate a new empty CNC program
O：Select an existed CNC program
S：Save current CNC program
A：Save current CNC program with a new name
D：Delete CNC program

Y：Shutdown the system in normal sequence 
automatically.

Note: It is strongly recommended to use the System Shutdown menu  item before turning off 
the power. The system shutdown menu item lets system has a chance to save the important 
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parameters of the system.

3.1.1  Menu Item : File→New

Select this menu item to initiate a new empty CNC program.

User can start to program a new CNC program, and then select the menu item〝File→Save 
as ... 〞or 〝File→Save as...〞to save the new CNC program.

3.1.2   Menu Item : File→Open...

ME3 system provides memory capacity to save CNC program, and how many bytes memory 
capacity has depends on the model of machines. Users also can load or save CNC programs 
from USB device〔This is an optional function.〕 

Select this menu item to open an〝Open a File 〞dialog box to select an existed CNC 
program. The dialog box only lists the files named with extension name〝.CNC〞. Users can 
open a file by direction key to select desired file or inputing file name.  

Note: Dialog box listing does not show extension name.
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Figure 3-3   An〝Open a File〞dialog box to select an existed CNC program in the ME3 controller.

Press F3 to switch the memory device to USB on the 〝Open a File〞dialog box. When your 
desired file is in ME3 controller, press F3 and then return to controller to open a file. The 
memory ∕ USB switch hint is on the right side of the 〝Open a File〞dialog box. 

Figure 3-4  This is a screen of〝Open a file〞dialog box from USB, and user can open a file from USB.
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3.1.3  Menu Item : File→Save...   

Select this menu item to save current program under the name shown on program title in 
controller or USB.

3.1.4  Menu Item : File→Save  as...

This file dialog box is to enter file name and  save file.

3.1.5  Menu Item : File→Delete File... 

Select this menu item to open a〝Delete a File〞dialog box to delete file selected. Press 
Enter to finish the deletion.

All operations are the same, no more mentions in the later chapter.

3.1.6  Menu Item : File→System Shutdown...

Shut down the system in normal sequence automatically.

Note: It is strongly recommended to use the System Shutdown menu  item under File 
submenu before turning off the power. The system saves its important parameters in the 
system shutdown procedure.
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3.2   Edit〔F2→E〕

Figure 3-5   The pull down menu: Edit

Description
T：Remove selected text from a CNC 
Program and put it on the clipboard
C：Copy selected text from the CNC 
program and put it on the clipboard
L：Clear the selected text
P：Insert a copy of the clipboard 
contents at the insertion point
F ：Search for specified character string 
and make it reverse white .
G：Go to a specific line
I  ：Help user on programming G code 
commands.
M：Show the detail information about 
the command pointed to by editor 
cursor. 

E：Input the position data to the CNC 
program automatically
R：Auto compute radius by 3 teach in 
point

The Edit submenu provides well known functions, such as 〝Cut, Copy, Paste, Find, 
Goto…〞. ME3 also provides more powerful functions, such as〝Command Insertion Aid, 
Command modification aid〞,〝Teach In〞,〝Compute Radius〞,  for the users who 
does not know the G or M codes well. 

3.2.1  Editor

Upon opening an existed program, it can be executed at once. When you want to modify an 
existed CNC program, press F3 key and switch from current mode to edit CNC program. 
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Operation Key Function Operation Key Function

→ Shift cursor right PgUp Page up

← Shift cursor left PgDn Page down

↑ Shift cursor up BS Delete a character forward

↓ Shift cursor down Delete Delete a character

Ctrl + → Shift right a word Ctrl + T Delete a word

Ctrl + ← Shift left a word Ctrl + Y Delete a line

Shift +↑↓→← Block an area Ctrl + Delete Delete a block

Home Shift cursor to line start Ins Insert Mode  

End Shift cursor to line end Ent New Line

Ctrl + Home Shift cursor to page top

Ctrl + End Shift cursor to page 
bottom

3.2.1.1   Menu Item : Edit→Find...

Use this Find command to search for specified character string.

A Find dialog box will pop up for users to type in the string for searching. When finish typing 
string and then press Enter key, the command executes and shows  specified character string 
highlighted.

Figure 3-6   A Dialog box : Find

43



 INCON-ME3 CNC Controller Guide of Milling 

3.2.1.2   Menu Item : Edit→Go to Line...

Executing this item can move a cursor to a specified line.

A Goto∕Jump dialog box will pop up for users to input line number desired.

Input the sign〝+〞or〝-〞in front of the line number, cursor moves up or down 〝nnn〞 

lines from the current line, else cursor moves to〝Line number〞lines from first line.

Figure 3-7   A Dialog box: Goto / Jump.

3.2.2  Clipboard

Clipboard is a buffer for cut or copied text.

The clipboard doesn't retain the information until you cut or copy another piece of context 
into the clipboard. The default clipboard is empty when power on.
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Figure 3-8   The selected text will be highlighted ,and the lower edge of the screen appears statusline under 
the〝Edit〞mode.

How to Select a Piece of Text 

Shift the cursor in the front of the text desired to cut or copy,  and then use the SHIFT + 
direction key to select a piece of text.

The selected text becomes highlighted at once and users can cut or copy a piece of text to the 
clipboard by〝Edit→Cut〞or〝Edit→Copy〞. Then users can paste it by〝Edit→Paste〞.

There is one more easier way to do above-mentioned motion: Under Edit mode, press F5 to 
copy, press F8 to cut, press F7 to paste and press F6 to clear the Piece of  Text.
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3.2.3   Command Aid

3.2.3.1    Menu Item : Edit→Command Insertion Aid

Select this menu item to pop up a submenu of command items which can be selected to help 
users on programming G code commands.

Figure 3-9  a submenu of command Insertion Aid

Description

P：G00
L：G01
C：G02、G03
Y：G73、G74、G76 and G81～G89
D：G70.07~G70.09
O：G70.21~G70.23
R：G70.00
I ：G70.01
E：G70.02
U：G70.03
T：G70.04
F：G70.05
S：G70.06
N：G70.10
K：G70.11

Note: These functions can be used 
under the Edit mode

Under Edit mode, Command Insertion Aid or Command Modification Aid function 
enables by pressing Alt+F4 or Alt+F5 all the time and its dialog box pop up for users to input 
data. 

Note: Instructions related to coordinate system are effective to Command Insertion Aid. For 
example, G17/G18/G19 plane selection, G20/G21 metric/ inch system, G90/G91 
absolute/ incremental dimension, G15/G16 Cartesian/ polar coordinate, G54~G59 work 
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coordinate selection, G52 child coordinate, the zero point of G92 setting and so on. 

There are some signs in front of input items in  the Command Insertion Aid dialog boxes. 
The followings are meanings of signs:

(1) 〝*〞：the item can be specified or not.
(2) 〝#〞：the item can be combined with other items which have the same sign, #, to 

become varied formats of commands.

I. Instructions related to route 〔Positioning, Linear and Circular interpolation〕

They are usually used in varied route cutting.

1.  Positioning〔G00〕

Format：G00 X_Y_Z_A_; 

When starting or finishing a route cutting, it is usually used the positioning instruction to go 
into or exit the route. The dialog box of G00 is as follows.

Figure 3-10   A command Insertion Aid dialog box: G00 positioning 

Note: Before input the data in the item of dialog box, users must know the settings related to 
coordinate system of the current program line to avoid errors. The settings are such as 
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metric/inch system, absolute / increment dimension or Cartesian / polar coordinate and so on.

When G00 follows G40/G41/G42, G00 also executes transiting into / out the compensated 
route.

2.  Linear interpolation〔G01〕

Format： G01 X_Y_Z_A_(R_/L_)F_;

Figure 3-11   A command Insertion Aid dialog box: G01 Linear interpolation

Note: Before input the data in the item of dialog box, users must know the settings related to 
coordinate system of the current program line to avoid errors. The settings are such as 
metric/inch system, absolute / increment dimension or Cartesian / polar coordinate and so on.

〝Corner Rounding〞、〝Chamfering〞specify the R / L value in the following figures, 
and can be just used in between the two interpolation instructions. 
 

Figure 3-12   The R value of Corner Rounding and the L value of chamfering
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The item〝Feed Rate〞having been set and users don't need to change its value,  users can 
not input value anymore and the setting keeps the last value automatically.

3.  Circular Interpolation〔G02/G03〕

Format： 

G02/G03 X_Y_(Z_)R_F_             ;Radius Mode
G02/G03 X_Y_(Z_)I_J_(I_K_ / J_K_)F_ ;Center Mode
G02/G03 I_J_(I_K_ / J_K_)A_F_      ;Angle Mode

The dialog box will help to insert G02/G03 into a CNC program. The end position of 
circular or arc can be edited by absolute / increment dimension or Cartesian / polar 
coordinate.

Figure 3-13   A command Insertion Aid dialog box: G02/G03 arc interpolation

The items with the〝#〞 sign in front of  item can combine with each other to generate 3 
kinds of varied formats of G02/G03, the following examples is in G17 mode:

(1) Radius Mode：Input〝X   X End Position〞,〝Y   Y End Position〞and〝R  Arc 
Radius〞. When the R value is negative, the arc will be more than 180 degrees.

(2) Center Mode：Input〝X   X End Position〞,〝Y   Y End Position〞and〝I   X Axis 
Center〞、〝J  Y Axis Center〞. 〝I   X Axis Center〞and〝J   Y Axis 

49



 INCON-ME3 CNC Controller Guide of Milling 

Center〞specify the distance from center to start point.
(3) Angle Mode：Input〝I   X Axis Center〞,〝J  Y Axis Center〞and〝A  Arc Angle〞.
 

The details of G02/G03 refer to Chapter 4.

II. Cancycle

Format：G73/G76/G83/G87 X_Y_Z_(R_Q_ K_F_)
Format：G74/G81/G84/G85/G86/G88/G89 X_Y_Z_(R_ K_F_)
Format：G82 X_Y_Z_(R_P_K_F_)

Figure 3-14   A command Insertion Aid dialog box: Cancycle

All meanings in these input items of  this dialog box are the same as ones of  Chapter 4 
Cancycles. Users input data in desired items according to varied cancycles.

The functions of G90/G91 and G98/G99 works under this mode.

Drilling cycle instruction codes：G81/G82、G73/G83
Boring cycle instruction codes：G81/G82、G76/G85~89
Tapping cycle instruction codes：G74/G84

The item〝K  Count〞in the dialog box specifies the repeat counts of the drilling can cycle.
When 〝X    Drill Pos / Depth X〞and〝 Y    Drill Pos / Depth Y〞 are specified under 
incremental dimension 〔G91 mode〕, this motion of drilling can cycle is the same as one of 
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〝D   Drill Pattern→L   Line Drill Pattern〞.

Figure 3-14  drilling can cycle

III. Drill Pattern

There are three drill patterns: line, Grid and Arc drill pattern.

Every can cycle instruction, G73~G89, are acceptable in this drill pattern, therefore the Drill 
Pattern also can do boring group or tapping. 

The items such as〝1st Axis...〞,〝2nd  Axis...〞in every dialog box of Drill Pattern means:
〝1st Axis...〞denotes  X axis and  〝 2nd Axis...〞denotes  Y axis under G17 mode. Other 
modes list as follows:

Plane Selection 〝1st Axis...〞 〝2nd  Axis...〞
G17 X Y
G18 Z X
G19 Y Z

1.  Line Drill Pattern

Format：G70.07 G_X_Y_Z_R_I_J_L_Q_P_F

The holes of cancycle of Line Drill Pattern are drilled in a line disposition.
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Figure 3-16   A dialog box: Line Drill Pattern

(1) 〝X〔Y, Z〕  Start Pos∕Depth X〔Y, Z〕〞: Drill pattern start position and depth. 
The input value can select G90/G91 mode and G98/G99 mode.

(2) 〝I   1st Axis Delta〞: Delta distance of 1st axis, which is the  distance between two 
consecutive drilling  position in 1st axis. 
〝J  2nd Axis Delta〞: Delta distance of 2nd axis, which is the  distance between two 
consecutive drilling position in 2nd axis

(3) 〝L  Count〞: Drill pattern counts. This item must be a non-negative number.
(4) After finishing the line drilling, the tool will stop at the initial level of the final position.

〔Note: the initial level means the 3rd axis position on the current plane 〔G17, G18 or 
G19〕.

(5) 〝Q   Step In Depth〞: Cut in depth. The depth U_ , V_ or W_ depends on plane 
selection〔G17, G18 or G19〕.

Figure 3-17  Line Drill Pattern
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2.  Grid Drill pattern

Format：G70.08 C_G_X_Y_Z_R_I_J_A_B_U_V_W_D_Q_P_F_

The holes of cancycle of Grid Drill Pattern are drilled in a checker disposition.

Figure 3-18    A dialog box: Grid Drill Pattern

〝X〔Y, Z〕  Start Pos∕Depth X〔Y, Z〕〞programs in G90/G91 mode. The items with 
〝#〞combine to each other to generate three following kinds of Grid Drill Pattern .

(1) Input the distance between two consecutive drilling position in 1st  / 2nd axis,〝I   1st Axis 
Delta〞and 〝J   2nd Axis Delta〞.And then input drill pattern counts of 1st  / 2nd 

axis〝A  1st Axis Count〞、〝B  2nd Axis Count〞.
(2) Input drill pattern end position〝U  End position X〞,〝V End position Y〞or〝W 

End position Z〞, which are defined respectively by two axes among U, V and W 
depends on which plane is specified. And then input drill pattern counts of 1st  / 2nd 

axis〝A  1st Axis Count〞、〝B  2nd Axis Count〞.
(3) Input drill pattern end position〔U, V or W〕and the distance between two consecutive 

drilling position in 1st  / 2nd axis , 〝I   1st Axis Delta〞and 〝J   2nd Axis Delta〞.

When input data including of end position 〔U, V or W〕, the distance between two 
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consecutive drilling position in 1st  / 2nd axis〔I, J〕and counts of 1st  / 2nd axis〔A, B〕, The 
end position will be ignored.

Figure 3-19   Grid Drill Pattern

Note: After finishing the line drilling, the tool will stop at the initial level of the final position.

〝D  Tilt Angle〞 : The tilt angle specifies the rotation angle around center(X,Y,Z). The 
item with 〝*〞means it is optional.

Figure 3-20   Grid Drill Pattern with  tilt angle

3.  Arc Drill Pattern

Format：G70.09 G_X_Y_Z_R_C_A_I_L_B_Q_P_F_

The holes of cancycle of Arc Drill Pattern are drilled in an arc disposition.
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Figure 3-21   A dialog box: Arc Drill pattern

Center position programs in absolute or incremental coordinate system.

The items with 〝#〞combine to each other to generate three following kinds of Arc Drill 
Pattern .

(1) Input〝I  Delta Angle〞and〝L  Count〞
(2) Input〝B  End Angle〞and〝L  Count〞
(3) Input〝B  End Angle〞and〝I  Delta Angle〞

Figure 3-22   Arc Drill Pattern
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〝I  Delta Angle〞: the angle between two consecutive drilling position. 

〝L  Count〞: Drill pattern counts.
〝B  End Angle〞: must be larger than〝A   Start Angle〞. The following figure is an 
example, End Angle must input 390°〔it is equal to 360°+30°〕 instead of 30°.

Figure 3-23   Start Angle and End Angle

When input data including of〝I   Delta Angle〞,〝L   Count〞and〝B   End Angle〞, 
〝B   End Angle〞will be ignored. After finishing the arc drilling, the tool will stop at the 
initial level of the final position.

IV. Object Pattern

The pocket, dowel, side surfacing and contour pocketing can be all combined with the 
instructions of rotation, mirror image and scaling to do each single object arrangement.
This controller also provides three kinds of regular object patterns to arrange array objects: 
linear, grid and arc patterns. @G70.10 or @G70.11 specified the arranged object must follow 
with these pattern arrangement instructions.

1.  Line Object Pattern

Format：G70.21 I_J_L_
               @ G70.10/G70.11 P_X_Y_………
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Figure 3-24   A dialog box: Line Object Pattern

〝I   1st Axis Delta〞 ：The distance between two consecutive object in 1st axis.
〝J   2nd Axis Delta〞 ：The distance between two consecutive object in 2nd axis.
〝L  Count〞 ：Object counts.  This has to be a non-negative number.

Figure 3-25   Line Object Pattern

The start position (X,Y)of first object is specified in the object  instruction ,   @ 
G70.10/G70.11. After finishing  Line Object Pattern, the tool will stop at the initial level 
of the final position.

2.   Grid Object Pattern

Format：G70.22 C_I_ J_A_B_(D_)
               @ G70.10/G70.11 P_X_Y_………
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Figure 3-26   A dialog box: Grid Object Pattern

〝C  Axis Orientation〞：Object cut orientation. C=0, cut object along 1st axis, transit along 
2nd axis, otherwise, cut object along 2nd axis, transit along 1st axis. 
〝I   1st Axis Delta〞 ：The distance between two consecutive object in 1st axis.
〝J   2nd Axis Delta〞 ：The distance between two consecutive object in 2nd axis.
〝A  1st Axis Count〞 ：Object counts of 1st axis.  This has to be a non-negative 
number.
〝B  2nd Axis Count〞 ：Object counts of 2nd axis.  This has to be a non-negative 
number.

Figure 3-27   Grid Object Pattern

〝D  Tilt Angle〞: The tilt angle specifies the rotation angle to start point of first object. The 
item with 〝*〞means it is optional.
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Figure 3-28    Grid Object Pattern with tilt angle

The start position (X,Y)of first object is specified in the object  instruction ,   @ 
G70.10/G70.11. After finishing  Line Object Pattern, the tool will stop at the initial level 
of the final position.

3.   Arc Object Pattern

Format：G70.23 (X_Y_/R_ A_)I_L_
              @ G70.10/G70.11 P_X_Y_………

Figure 3-29   a dialog box : Arc Object Pattern

〝 X/Y/Z   Center X/Y/Z〞：Center of object pattern, which are defined by two of the axes 
among X, Y and Z depends on  the plane specified. These are the distances from the first 
object to the center. 
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〝R  Pattern Radius〞：Radius of object pattern. This has to be a non-negative number.
〝A  Pattern Center Angle〞：This is the angle from the 1st axis to the vector from first 
object to the center of the object pattern. 
〝I  Delta Angle〞：The angle between two consecutive object.  This has to be a non-
negative number.
〝L  Count〞：Object counts. This has to be a non-negative number.

Figure 3-30   Arc Object Pattern

The start position (X,Y)of first object is specified in the object  instruction ,   @ 
G70.10/G70.11. After finishing  Line Object Pattern, the tool will stop at the initial level 
of the final position.

V. Common Characteristics in Side surfacing/ Pocketing/ Dowel 

There are some common characteristics in the side surfacing, pocketing and dowel 
commands. These characteristics are defined as follows:

1.   Corner Rounding

This function adds arcs of radius R to the four corners of rectangular. It is applied to the 
contour of rectangular only in side surfacing or pocketing or dowel commands.
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Figure 3-31    Corner Rounding

2.   Chamfering

This function adds chamfers to the four corners of rectangular. It is applied to the contour of 
rectangular only in side surfacing or pocketing or dowel commands.

Figure 3-32   Chamfering

3.   Tilt

This function tilt the contour of rectangular and track field with a tilt angle. It is applied to 
both rectangular and track field in side surfacing or pocketing or dowel commands.

Figure 3-33   Tilt
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VI.  Pocketing

There are two pocketing instructions: rectangular and circular pocket .On using these pocket 
instructions, some common rules must be noticed:

(1) 〝G  Orientation 〞〔CW/CCW 〕will create G02/G03 in the command line, and the 
five selection items in〝P  Step In Axis〞will create P0~P4 in the command line.

(2) Before the pocket cutting, the tool table number〔D_〕and the radius of the tool must be 
set previously so that the system can get the correct radius data for pocket cutting.

(3) Pocket commands are classified to one shot command means each block of pocketing 
must be specified by G70.xx. For continuous blocks of pocketing, when programming 
directly by Editor instead of  Command Insertion Aid, the G70.00/70.01 and the new 
central position (X,Y,Z,)of the pocket must be specified. The other variables will use 
the previous setting.

(4) The d value〔d means cut in retract length〕 in the figures is the same as one specified in 
the 〝parameter→cancycle parameters→Cut In Retract Length〞, so don't specify it 
again.

(5) When fine feed width 〔J_〕and fine feed depth〔K_〕 haven't been specified, the last 
fine cutting isn't performed. Under G70.00 mode, when L_/R_ hasn't been specified, 
corner chamfering /rounding isn't performed.

(6) When E_ hasn't been specified，fine feed rate is performed with half of F_ instead of 
E_.

(7) After finishing the pocket cutting, the tool will retract to the pocket center and the initial 
level.

The motions of the instruction are as below:

(1) The tool moves rapidly to the  pocket center(X,Y) and the safe level(Z+C).
(2) Cut in depth 〝Q  Step In Depth〞 for each drilling step in speed〝I  Spindle Feed 

Rate〞.
(3) Do pocket cutting in speed 〝F  Feed Rate〞according to selected orientation.
(4) When finishing pocketing the current layer, the tool retract at the initial level and 

positioning to the pocket center.
(5) Cut in depth〔Q_〕again and do pocketing the next layer in speed〝I  Spindle Feed 

Rate〞.
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(6) Repeat the steps (1)~(5) until reach the specified depth〔W_〕.
(7) Do fine cutting in speed 〝E  Fine Feed Rate〞finally.
(8) When finishing pocketing, the tool retract at the initial level  and stop at the pocket center.

Pocket cutting each layer is broadened from the pocket center  circle by circle. The broadened 
width is specified by〝Parameter→Cancycle Parameters→Step In Width〞, which 
provides 4 selections 150%, 125%, 100% and 75%.

1.   Rectangular Pocket

Format：

G70.00 (G02/G03) P_X_Y_Z_U_V_W_C_J_K_Q_(R_/L_)D_I_E_F_

Figure 3-34   A dialog box: Rectangular Pocket

(1) The pocket center(X,Y)and initial level Z_ can program in absolute or incremental 
dimension

(2) U_/V_/W_   : Pocket length, width, and depth, which are defined respectively by U_, V_ 
and W_ depends on which plane is specified. Length and width have to be non-negative 
number. The sign of the depth determines the  direction of drilling.

(3) The radius of the tool number in 〝Parameter→Tool Table〞must be set previously, or 
rectangular pocket doesn't run.
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(4) Corner rounding and chamfering are optional items. When both are specified, chamfering 
will be ignored.

(5) When E_〔Fine Feed Rate〕 hasn't been specified，fine feed rate is performed with 
half of F_ 〔Feed Rate〕instead of E_.

(6) 〝D  Tilt Angle〞: Pocket tilt degree. This is the angle  rotates from the rectangular 
pocket center with CCW orientation.

Rectangular Pocket with corner rounding:

Figure 3-35   Rectangular Pocket with corner rounding                                  

Rectangular Pocket with chamfering：
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Figure 3-36   Rectangular Pocket with chamfering

Rectangular Pocket with chamfering and tile angle:

Figure 3-37   Rectangular Pocket with chamfering and tile angle

2.  Circular Pocket

Format： G70.01 (G02/G03)(P_) X_Y_Z_R_U_(C_ J_ K_)Q_I_(E_ F_)

65



 INCON-ME3 CNC Controller Guide of Milling 

Figure 3-38   A dialog box: Circular Pocket

(1) The pocket center(X,Y)and initial level Z_ can program in absolute or incremental 
dimension

(2) 〝R   Pocket Radius〞: Pocket corner rounding radius.
(3) The radius of the tool number in 〝Parameter→Tool Table〞must be set previously, or 

rectangular pocket doesn't run.
(4) When E_〔Fine Feed Rate〕 hasn't been specified，fine feed rate is performed with half 

of F_ 〔Feed Rate〕instead of E_.
(5) 〝G   Orientation〞:Cutting orientation. G02 for CW, G03 for  CCW.

Figure 3-39   Circular Pocket
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VII.   Dowel

There  are two Dowel cutting: rectangular and circular Dowel.

The motions of  these instructions are as below:

(1) The tool moves rapidly to the start position (XS,YS), which is calculated automatically 
by the input value(X,Y,U,V), and safe level (Z+C).

(2) Cut in depth 〝Q    Step In Depth〞 for each drilling step in speed〝I    Spindle Feed 
Rate〞.

(3) Do Dowel cutting in speed 〝F  Feed Rate〞according to selected orientation.
(4) When finishing Dowel cutting the current layer, the tool retract at the initial level and 

positioning to the dowel center.
(5) Cut in depth〔Q_〕again and do doweling the next layer in speed〝I  Spindle Feed 

Rate〞.
(6) Repeat the steps (1)~(5) until reach the specified depth〔W_〕.
(7) Do fine cutting in speed 〝E  Fine Feed Rate〞finally.
(8) When finishing doweling, the tool retracts at the initial level  and stops at the dowel 

center(X,Y).

Dowel cutting each layer is broadened from the pocket center  circle by circle. The broadened 
width is specified by〝Parameter→Cancycle Parameters→Step In Width〞, which 
provides 4 selections 150%, 125%, 100% and 75%

1.  Rectangular Dowel

Format：G70.02(G02/G03)(P_)X_Y_Z_U_V_W_A_B_(C_ J_K_)Q_(L_/R_ D_) I_(E_F_)
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Figure 3-40   A dialog box: Rectangular Dowel

(1) The dowel center(X,Y)and initial level Z_ can program in absolute or incremental 
dimension

(2) U/V: dowel length, width. 
(3) A/B: Perimeter length and width. 

Keep in mind: The value  A/B must be larger than  U/V, or the program error occurs and 
doesn't work. 

(4) 〝D  Tilt Angle〞: Dowel tilt degree. This is the angle  rotates from the rectangular 
dowel center with CCW orientation.

(5) When E_〔Fine Feed Rate〕 hasn't been specified，fine feed rate is performed with half 
of F_ 〔Feed Rate〕instead of E_.

(6) Corner rounding and chamfering are optional items. When both are specified, chamfering 
will be ignored.

(7) When E_〔Fine Feed Rate〕 hasn't been specified，fine feed rate is performed with half 
of F_ 〔Feed Rate〕instead of E_.
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Figure 3-41   Rectangular Dowel

2.   Circular Dowel

Format： G70.03 (G02/G03) (P_)X_Y_Z_R_U_ A_(C_J_K_)Q_ I_(E_F_)

Figure 3-42   A dialog box: Circular Dowel
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(1) The dowel center(X,Y)and initial level Z_ can program in absolute or incremental 
dimension

(2) R_ is dowel corner rounding radius. A_ is Perimeter radius.
(3) Keep in mind:〝A    Perimeter Radius〞must be larger than〝R   Dowel Radius〞,or 

the program error occurs and doesn't work. 
(4) The radius of the tool number in 〝Parameter→Tool Table〞must be set previously, or 

rectangular pocket doesn't run.
(5) When E_〔Fine Feed Rate〕 hasn't been specified，fine feed rate is performed with half 

of F_ 〔Feed Rate〕instead of E_.

Figure 3-43  Circular Dowel

VIII.  Side Surfacing

There are two side surfacing: outside surfacing and inside surfacing.

Every side surfacing  provides two types of contour: rectangular and circular.

The motions of  these instructions are as below:
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(1) The tool moves rapidly to the start position (XS,YS), which is calculated automatically 
by the input value(X,Y,U,V), and safe level (Z+C).

(2) Cut in depth 〝W  Length / Depth  Z〞 , and do side surfacing  with selected orientation 
in speed〝I  Spindle Feed Rate〞.

(3) When finishing side surfacing, the tool retracts at the initial level  and stops at the Side 
surfacing center(X,Y).

Note:

(1) The start position is located at the distance of the radius twice from the contour of side 
surfacing. Keep in mind: don't make a mistake to cut some part of the work piece at the 
distance.

(2) When starting  side surfacing, the tool cuts into the surface of side surfacing with a semi-
circle path. When finishing side surfacing, the tool leaves out the the surface of side 
surfacing with a semi-circle path.

1.   Rectangular Outside / Inside  Surfacing

Format： G70.04 (G02/G03)I_(P_)X_Y_Z_U_V_W_ (L_/R_ D_ F_)

Figure 3-44  A dialog box: Rectangular side surfacing
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Rectangular Outside  Surfacing and Rectangular Inside Surfacing  are both set by the 
dialog box.

〝I   Direction〞: Rectangular Side Surfacing direction. I0 for outside surfacing〔from 
outside toward inner〕, otherwise, I1 for inside surfacing〔from inside toward outer〕.

Figure 3-45   Rectangular Outside Surfacing                      Figure 3-46   Rectangular Inside Surfacing

(1) The rectangular side surfacing center(X,Y)and initial level Z_ can program in absolute 
or incremental  dimension

(2) U/V/W   : Side surfacing length, width, and depth.  
(3) 〝D  Tilt Angle〞: Side surfacing tilt degree. This is the angle  rotates from the 

rectangular side surfacing center with CCW orientation.
(4) The radius of the tool number in 〝Parameter→Tool Table〞must be set previously, or 

rectangular side surfacing doesn't run.
(5) Corner rounding and chamfering are optional items. When both are specified, chamfering 

will be ignored.

2.   Circular Outside / Inside  Surfacing

Format： G70.05 (G02/G03) I_(P_)X_Y_Z_ R_U_( F_)
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Figure 3-47   A dialog box: Circular Side Surfacing

〝I   Direction〞: Circular Side Surfacing direction. I0 for outside surfacing〔from outside 
toward inner〕, otherwise, I1 for inside surfacing〔from inside toward outer〕.

Figure 3-48   Circular Outside Surfacing                              Figure 3-49   Circular Inside Surfacing

(1) The rectangular side surfacing center(X,Y)and initial level Z_ can program in absolute 
or incremental  dimension

(2) U/V/W: Side surfacing length, width, and depth.
(3) The radius of the tool number in 〝Parameter→Tool Table〞must be set previously, or 

rectangular side surfacing doesn't run.
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IX.   Surfacing

Format： G70.06 D_X_Y_Z_U_V_W_C_I_F_

There are four surfacing mode:

D=0: cut along X axis, vertical transition
D=1: cut along Y axis, vertical transition
D=2: cut along X axis, tilt transition
D=3: cut along Y axis, tilt transition

The motions of  the instruction are as below:

(1) The tool moves rapidly to the start position (XS,YS), which is calculated automatically 
by the input value(X,Y,U,V), and safe level (Z+C).

(2) Cut in depth 〝W  Length / Depth  Z〞 , and do surfacing  with selected orientation in 
speed〝I  Spindle Feed Rate〞.

(3) When finishing Surfacing, the tool retracts at the initial level  and stops at the  Surfacing 
center(X,Y).

Figure 3-50   A dialog box: Surfacing
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(1) The surfacing center(X,Y,Z) can program in absolute or incremental  dimension
(2) U_/V_ is defined the length of  X / Y axis of surfacing  rectangle.
(3) During Surfacing,，The width per step in  is set by〝Parameter→Cancycle 

Parameter→Step In Width〞, which provides four selections ,150%, 125%, 100% and 
75%.

Figure 3-51   Surfacing〔D1 mode〕

1.   Surfacing , LeftRight / without Tilt〔D0〕 

Upon the tool does surfacing and shifts the distance U_along X axis,  the tool turns to Y axis 
and shifts the distance〝Step In Width〞. Then the tool dose surfacing and shifts back the 
distance U_along X axis, the tool turns to Y axis and shifts the distance〝Step In 
Width〞again. Then the tool does along X axis again..... Do the above-mentioned motions 
again and again until finish all surfacing process. 

2.  Surfacing , UpDown / without Tilt〔D1〕

Upon the tool does surfacing and shifts the distance V_along Y axis,  the tool turns to X axis 
and shifts the distance〝Step In Width〞. Then the tool dose surfacing and shifts back the 
distance V_along Y axis, the tool turns to X axis and shifts the distance〝Step In 
Width〞again. Then the tool does along Y axis again..... Do the above-mentioned motions 
again and again until finish all surfacing process. 
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3.   Surfacing , LeftRight / with Tilt〔D2〕

Upon the tool does surfacing and shifts the distance U_along X axis,  the tool goes back with 
a hypotenuse transition 〔the hypotenuse has two legs of right triangle, U_ and the 
distance〝Step In Width〞along Y axis〕. Do the above-mentioned motions again and again 
until finish all surfacing process. 

4.    Surfacing , UpDown / with Tilt 〔D3〕

Upon the tool does surfacing and shifts the distance V_along Y axis,  the tool goes back with a 
a hypotenuse transition 〔the hypotenuse has two legs of right triangle, V_ and the 
distance〝Step In Width〞along X axis〕. Do the above-mentioned motions again and again 
until finish all surfacing process. 

Figure 3-52   Four modes of surfacing

X. Contour Pocket∕ Contour Pocket Side Surfacing

Any closed loop contour can be pocketed layer by layer or do the side surfacing with the tool 
radius compensation.

1.    Contour Pocket

Format： G70.10 (G41/G42) P_X_Y_Z_(U_V_W_)C_J_K_Q_R_I_E_F_
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Figure 3-53   A dialog box: Contour Pocket

P ：Subroutine number of the contour. The subroutine follows main program and  it is 
named by Oxxxx .
X,Y,Z：Contour offset and start position, which are defined respectively by X, Y and Z 
depends on the plane specified. The offset is the distance of the contour pocket position from 
the standard contour pocket defined in subroutine P.
C ：Safety clearance, which is the distance to the pocket start position.
U/V/W： Contour depth, which is defined by U_, V_ or W_ depends on which plane is 
specified. The sign of the depth determines the direction of drilling.
J : Fine feed width. Motion in this stage is with fine feed rate.  This has to be a non-
negative number.
K : Fine feed depth. Motion in this stage is with fine feed rate.  This has to be a non-
negative number.
Q ：Cut in depth, which is the infeed amount for each drilling step.
R ：Approach radius, which is the radius to approach for fine finish.
I ：Spindle axis feed rate.
E ： Fine feed rate. This is a modal state. This has to be a non-negative number.
F : Feed rate. This is a modal state. This has  to be a non-negative number.
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Figure 3-54  Contour Pocket 

2.   Contour Pocket Side Surfacing

Format：G70.11 P_X_Y_Z_(U/V/W_)(C_)R_I_(F_)

Figure 3-55  A dialog box: Contour Pocket Side Surfacing 

P ：Subroutine number of the contour. The subroutine follows main program and  it is 
named by Oxxxx .
X,Y,Z：Contour offset and start position, which are defined respectively by X, Y and Z 
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depends on the plane specified. The offset is the distance of the contour pocket position from 
the standard contour pocket defined in subroutine P.
C ：Safety clearance, which is the distance to the pocket start position.
U/V/W： Contour depth, which is defined by U_, V_ or W_ depends on which plane is 
specified. The sign of the depth determines the direction of drilling.
R ：Approach radius, which is the radius to approach for fine finish.
I : Spindle axis feed rate. This has to be a non-negative number.
F : Feed rate. This has to be a non-negative number.

Figure 3-56    Contour Pocket Side Surfacing

3.2.3.2  Menu Item : Edit→Command Modification Aid 

Select this menu item to pop up a dialog box which shows the detailed information about the 
instruction pointed to by editor cursor. This item can help users to modify motion instructions.
The descriptions of the hot keys are as below:

F3 Mod & Nxt : Modify the current line and the dialog box pops the next line.
F4 No & Nxt : Don't modify the current line and the dialog box pops the next line.
F5 Mod & Prv : Modify the current line and the dialog box pops the previous line.
F6 No & Prv : Don't modify the current line and the dialog box pops the previous 
line.
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Figure 3-57   A dialog box: Command Modification Aid

Note: The function can be used under the Edit mode.

Press Esc to leave the Edit mode after finishing editing. And then press 〝F2→ F→S〞 to 
save the current program. You can also do it by the hot key F3.

3.2.4  Menu Item : Edit→Teach In

You can do manual operation when you edit a CNC program. Move the tool to touch the 
surface of part model and press Alt+T to teach in program position on the specified axis.

Select this menu item to create a command line with the program position of each specified 
axis,  then insert this command line into the editor at the cursor position. The teach in axis is 
specified in set teach in axis parameter.
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For instance: The current program position is(123.000, 100.120)

The inserted command line will be X123.000 Z100.120, when all axis are specified.

The command line will be X123.000, when only X axis is specified.

3.2.5  Compute Radius

We know a geometric rule : A circle is defined by three points not in a line .

INCON-ME3 provides a function which computes radius of this arc defined by three points 
not in a line . Locate the cursor at the next line of the command lines of three points,  select 
this menu item or press Alt+R ,  so the radius will be calculated and the 2nd,3rd  line will be 
replaced by computed G02 or G03 code automatically.

This function works under absolute dimension mode.  Both X_ and Y_  in the command lines 
of three points must exist.

System alarms when three point specified locates in a line.

Here is example:

Before computing radius :

G00 X+000.000 Y+000.000
G01 X+003.000 Y+004.000
G01 X+000.000 Y+004.000

Locate cursor right after the third line and press Alt+R. The program will be :

G00 X+000.000 Y+000.000
G02 X+003.000 Y+004.000 R+002.500
G02 X+000.000 Y+004.000 R+002.500
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3.3  Run Program〔F2→R〕

Figure 3-58  The Run submenu

Description

 R：Program execution
 U：Execute program from the cursor pointed line 
I ：Simulate program execution

 S：Stop running program
 H：Pause running program
T：Toggle switch，run Single Step or continuously

K：Toggle switch，switch machine lock or unlock 
A：Toggle switch, spindle axis lock/dislock motion
D：Toggle switch，switch Dry run or not
C：Toggle switch，switch Block skip or not
O：Toggle switch，switch  M01 running or not 
M：Manual Direct Input

N：Direct run .DNC program from hard disk
3：Ignore M30 in direct running under DNC mode
G：Switch to graphic mode or not

〝Toggle switch〞is the same as state switch, each being selected will change to one mode or 
the other mode, such as Off→On and On→Off; Disable→Enable and Enable→Disable. 

3.3.1   Menu Item: Run→Run program

Select this menu item to execute a program according to the run state defined in 
〝Parameter→Default Status→Set Run Mode〞.

Run program starts from the current cursor position. Commands before the current cursor 
position, such as Status Change G-code and Motion G-code are all ignored because of no 
executing program from the beginning.
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Warning: Watch out for the safety on machine limits before start to run.

3.3.2   Menu Item: Run→Run From Middle

Select this menu item to emulate a fast run of program from the beginning to the  line and task 
number of selected file according to the run state defined in the run state item of user 
parameter. This way, INCON-ME3 system can obtain the status for program to run. After the 
fast emulation run is over, a dialog box will pop up for user to confirm program execution or 
abort.

Warning: Watch out for the safety on machine limits!

When in program run state,〝Run from middle〞will restore the conditions, except M,S, and 
T codes, which are set by the program of previous to the cursor located. On selecting 〝Run 
from middle〞, it will pop out a dialog box as follows:

This dialog box is for user to input the desired CNC program name, line number, task number 
and hit count from which program will start running.

Figure 3-59   The dialog box:  Run from middle
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After finishing the above-mentioned dialog box, a Confirm dialog box will pop up to notice 
whether users restore M, S and  T code original conditions before executing Run From 
Middle. If  not,  set  M, S and  T code conditions well by MDI. When everything is ready,  the 
function Run From Middle will execute from middle line. The function is used to resume 
program from the interrupted command.

Figure 3-60   The Confirm dialog box:  Run from middle

3.3.3   Menu Item : Run→Simulate

Select this menu item to simulate program run according to the run state defined in the run 
state item of user parameter. The simulate mode will run the system in simulate speed without 
actually moving the machine table. User can use this item to verify the correctness of the 
program.

3.3.4   Menu Item : Run→Stop F10, Hold and  Step
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Stop F10

Select this menu item〔or press F10〕 to abort program execution immediately. This is the 
same as pushing the Emergency Stop button to stop all the motion. This button will always 
exist on another control panel provided by machine maker.

Hold

Select this menu item to enter the system in hold state and hold the motion temporarily. You 
can press F9 to leave the  hold state and resume program execution.

This menu item acts as a toggle switch to set∕clear the single step status.

Step

If the single step status was set, the SST status in system state window will be reversed white, 
and the program execution will run only one line. Each F9 is pressed and the program pointer 
will stay at the current line.

If the single step status was cleared, pressing F9 will run the program without pausing.

3.3.5  Run→Machine Lock, Spindle Axis Lock, Dry 
Run, Block Skip, Optional Hold  

Machine Lock∕Spindle Axis Lock∕Dry Run∕Block Skip∕Optional hold: these five 
functions will toggle these related state to turn on or turn off only. When press F9 to start 
running CNC program, the system checks these four states automatically and follows states to 
execute the CNC program:
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Machine Lock:

This menu item acts as a toggle switch to lock∕unlock the machine.

This action will be effective both during program execution and manual control. If switched 
to machine lock, the MLK status in system state window will be white reversed, and the 
machine will not move at all.

Spindle Axis Lock :

This menu item acts as a toggle switch to lock/unlock the spindle axis.

This action will be effective both during program execution and manual control. If switched 
to spindle axis lock, the SLK status in system state window will be white reversed, and the 
spindle axis will not move at all.

Dry Run〔Ctrl+F3〕: 

This menu item〔or press Ctrl+F3〕 acts as a toggle switch to enable∕disable dry run state. 

If the Dry Run state is enabled, the Dry status in system state window will be highlighted and 
all feed commands 〔G01, G02, G03, G32〕 will be executed in dry run speed.
〔Ignore the F code in the program〕

Dry Run speed is set by〝Machine parameter→Dry run speed〞. When Dry Run speed 
need to be transformed, please call your machine maker for service.

Block Skip〔Ctrl+F4〕:

This menu item 〔or press Ctrl+F4〕acts as a toggle switch to enable∕disable block skip. 
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If it is enabled, the∕SK status on system state window will be highlighted, and command 
lines with a leading〝∕〞will be ignored.

Optional Hold〔Ctrl+F5〕:

This menu item〔or press Ctrl+F5〕acts as a toggle switch to enable∕disable M01.

If it is enabled, the M01 status on system state window will be highlighted, and M01 in the 
program will act exactly like M00 to pause the program until press F9 to resume. If  it isn't 
enabled, M01 will be ignored. Then program continues to run.

Note: During program running, the state of 〝Machine lock〞can not be changed, but the 
other four states can be changed at any time. 

3.3.6  Menu Item: Run→MDI...

MDI〔Manual Direct Input〕can be used to input and execute one single line of CNC 
commands exclusively. Select this menu item will open an MDI dialog box for you to enter 
one line of commands and execute it at once.
  

You can also use down arrow 〔↓〕key to recall the commands that was entered previously.

After making sure that the command line is correct, press ENTER to execute, Esc to abort 
MDI motion, F10 to stop the whole system〔including the program that is running〕.

Warning: Press ENTER key will execute the command in the input line immediately. Notice 
the safety on machine limits before pressing the ENTER key!
MDI〔Manual Direct Input〕can be used to input and execute single line of CNC commands 
exclusively. Select this menu item will open a MDI dialog box for users to enter single line of 
commands and execute it at once.
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You can also use down arrow 〔↓〕key to recall the commands entered previously.

After making sure that the command line is correct, press ENTER to execute, Esc to abort 
MDI motion, F10 to stop the whole system〔including the running program〕.

Warning: Press ENTER key will execute the command in the input line immediately. Notice 
the safety on machine limits before pressing the ENTER key!

Figure 3-61   A dialog box: MDI

When the program execution has been paused by M00/M01, MDI can be used to insert single 
line program execution. When the program has been paused by M00/M01 during tool radius 
compensation, this system will not allow MDI to input any Motion G-code instructions but 
will still allow to input Status Change G-code instructions.

Press the hot key F7 to pop up a MDI dialog box.

If the machine maker opens  multi-line MDI commands on PLC setting, executing MDI will 
not pop signal line mode〔as above figure 3-61〕 but a MDI Edit Window on the left top of 
the main screen, and the program will be executed from the line cursor pointed to end line.
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Figure 3-62   The multi-line MDI Edit Window

3.3.7     Menu Item : Run→Direct Run...

Select this menu item to open an Open Direct Run File dialog box to select an existed DNC 
program to run under the direct run mode.
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Figure 3-63 an Open Direct Run File dialog box

3.3.8   DNC M30 Nonstop

This menu item〔or press Ctrl+F2〕acts as a toggle switch to enable/disable DNC M30 
Nonstop state.  Normally, the M30 status in system state window is highlighted. In this 
situation, M30 will stop running program. If the DNC M30 Nonstop state is enabled, the M30 
status in system state window will not be highlighted so that M30 command from DNC will 
not stop running program. In such case, users can run series of files by〝Run→Direct 
Run→Run File List〞.

This Run File List dialog box is for user to make a series of run file list for machine to run 
consecutively. To run multiple files, user has to switch the system to DNC M30 Nonstop 
mode.

The following are keys to make the list:

● Ins : to select files from a  file dialog box for running.
● Del :  to delete the selected file from the list.
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3.3.9   Menu Item : Run→Graphics

Select this menu item to switch to graphic mode.

There are some keys can be used to configure the graphic environment:

Ctrl+Del : Clear the graphic view
Ctrl+Arrow keys : Move the graphics up∕down∕left∕right
Ctrl+I∕Ctrl+O : Zoom in∕out the X and Y axis of graphics
Ctrl+Home : Center the graphic cursor
ESC : Exit the graphic mode.

Figure 3-63   The trace  window is on the right bottom of  the screen.

Also some keys to control the execution of program:

F5 : single step
F8 : hold
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F9 : run
F10 : emergence stop

3.4  Parameter〔F2→P〕

Parameter is used for users to confirm or set situations or values, their description is as below:

Figure 3-64   The Parameter sub menu

C：The offset setting of six work coordinates
T：Tool radius and length offset setting
R：4 reference points offset setting
N： Tool length measurement setting
X：Select a axis for teaching in
Y：Can cycle setting
S：Default scaling magnitudes setting
O：Default rotation angle setting
A：Set the default modal attribute of system

P：Save User Parameter in MECNC document
L：Load User Parameter in MECNC 
document
M：For viewing of related machine data

In dialog boxes under Parameter submenu, press Enter to save and Esc to leave.

3.4.1  Menu Item : Parameter→Coordinate offsets... 

This dialog box is used to set the coordinate offsets of  G54~G59, and also shows the current 
offsets of G92 and G52.
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Figure 3-65   A dialog box: Coordinate Offset

There is also a function key F4 shown in the statusline, when it is pressed, the current system 
offset of the selected axis of the selected work coordinate system will automatically be 
calculated and put into the input line. After that, if Enter key is pressed, the calculated offset 
value will replace the original value; else, if Esc key is pressed, the original value will not be 
replaced.

3.4.2   Menu Item : Parameter→Tool Table

This is a table for tool parameter setting.  The parameters are tool radius and tool length.
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Figure 3-66   A dialog box: Tool table

Use D_ code to select tool radius compensation data set numbers of this tool table. Use H_ 
code to select tool length compensation data set numbers of this tool table.

Tool radius compensation is activated by G41 or G42. Tool length compensation is activated 
by G43.

Note：

1. The tool table provides 128 tool settings.〔Every 10 tools per one page in the dialog box. 
Use PgUp and PgDn to switch page.〕

2. The tool length value is a tool adjustment compared to a normal tool, therefore it can be 
positive or negative value.

3. The tool radius value must be positive only, and do left or right compensation by 
G41/G42.

4. 〝Wear〞means a tiny wear after using a tool for a period. For the more correct cutting 
size, the wear value must fill in the table.

5. Length = machine position – Measure Height
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3.4.3  Menu Item : Parameter→Reference Position

Select this menu item to open a Reference Position dialog box to set four reference positions 
relative to the origin of machine coordinate.

Figure 3-67   A dialog box : Reference Position    

3.4.4  Menu Item : Parameter→Tool Length 
Measurement Parameter...

Select this menu item to open a Tool Length Measurement Parameter dialog box to set the 
parameters for tool length measurement.

Figure 3-68 A dialog box: Tool Length Measurement Parameter 
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Search speed : Don't set this value too fast to crash the probe or tool tip.
Detect speed : It is usually a very slow value to get high precision.
Retract distance : Don't set this value too long to waste time. 
Detect distance : Don't set this value too long to protect the tool or probe.

3.4.5   Menu Item : Parameter→Set Teach In Axis

This dialog box is for user to set teach in axis.
On editing a program, we can use the manual operation to move the tool to trace a model or 
an object point by point. And then press Alt + T keys to insert the position value of selected 
axes in this parameter to the program, and generate the program of manual tracing 
automatically.

Figure 3-69  A dialog box: Set Teach In Axis

3.4.6   Menu Item : Parameter→Cancycle Parameter

In Cancycles, both G73/G83 pecking drilling do the action of retraction to dispose the chips. 
This retract distance〔the d value in G73/G83 figures 〕 is set by 
〝Parameter→Cancycle Parameter→Cut In Retract Length〞. 〔unit :mm/ inch〕.

In  G70.00/70.01 pocket instruction, do the action of retraction after each layer 
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machining. The retract distance is also set by 〝Parameter→Cancycle Parameter→Cut In 
Retract Length〞.

Figure 3-70  A dialog box: Cancycle Parameter

〝Step In Width〞:the distance which tool cuts from one cycle to another broadened cycle 
each layer when executing pocket.  The〝Step In Width〞provides four radius rate settings: 
75%, 100%, 125% and 150% .

Figure 3-71  There are four radius rate of Step In Width：75%、100%、125% and 150%.

3.4.7   Menu Item : Parameter→Scaling Magnitudes

Select this menu item to open a Default Scaling Parameter dialog box to set the default 
scaling magnitudes of each axis and scaling least increment for the format of magnitudes.
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Figure 3-72  a dialog box: Default Scaling Parameter

The formats of I_,J_,K_ and P_of G51 are different from ones of other instructions. 
Decimal is not allowed in G51 instruction. The value inputed here means magnification, for 
example, I20000 means the magnification is 20 when select 〝Scaling ¾ Digit least→(●) 3 
Digit Least Inc〞, but it means the magnification is 2 when select 〝Scaling ¾ Digit 
least→(●) 4 Digit Least Inc〞.

When  I_,J_,K_ and P_of G51 are not specified, 〝Scaling Magnitudes→P Value〞is 
viewed as the magnification for all axes. When one of I_,J_ and K_ is not specified, its 
magnification will be replaced by P Value. The default P Value is just positive number.

3.4.8  Menu Item : Parameter→Rotation Angle...

Select this menu item to open a Default Rotation Parameter dialog box to set the default
rotation angle and absolute or incremental angle mode for rotation.

Figure 3-73   A dialog box: Default Rotation Parameter
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Rotation angle Incremental/absolute : specify the R_ code value in G68 is in incremental or 
absolute sense.
Angle: when A_ code is not specified in G68 instruction, A_ will be replaced by the Angle 
value of this dialog box.

Note:

The radius programs by absolute or incremental  dimension depending on G90/G91. The 
angle does depending on〝Parameter→Rotation angle→Rotation Angle Abs / Inc〞.

3.4.9   Menu Item : Parameter→Attribute

Select this menu item to open a Default Status dialog box to set the default modal attribute 
when system starts up.

The language can be set to English and Chinese.

Figure 3-74   A dialog box: Default Status
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This dialog box set the default modal attribute of system when system starts up. These default 
modal attribute includes:

G00/G01,G20/G21,G90/G91 and G60/G61.

Check item :

● ESC save modified program: If this item is selected, modified program will 
automatically be saved when Esc is pressed. If not,  modified program will pop up a 
confirm dialog box to ask whether users save the program, press Y to save it and press N 
not to do.

● Error message for tool compensation overcut: If this item is selected, error message 
will be signaled when overcut happens in tool radius compensation.  Otherwise, a 
smoother path defined by this application will be taken.

● Treat no dot as with dot : If this item is selected, a command value without decimal point 
will be treated as one with decimal point. It is usually specified a real number in a normal 
program but users input a integer number ,which is transformed integral multiple of the 
system least unit. For example: the inputed value, X1234, is transformed as X1.234. 
When this item is selected,  the inputed value, X1234, is transformed as X1234.,which 
is the same as X1234.000.

● Not switch graph plane automatically ( END key ) :If this item is selected, the display 
plane of trace window will not switch because of change of  G17/G18/G19 
automatically. It can be switched by End key.

Set Run Mode :

The item is used to choose run mode. The Run Mode means system executes a program from 
controller itself or DNC.

Language :

The language mode of the system can be set to English or Chinese mode. It works after reset.

100



 Chapter 3  Pull Down Menu 

Time Zone :

To set time of controller upon where machine is. 〝GMT〞 means the standard time in 
Greenwich. For example, if it is in Taiwan, key in 〝+8:0〞;  if it is in Kathmandu, key in 
〝+5:45〞 ; if it is in the east of  America, key in 〝-5:0〞...and so on.

Max G60 turn angle :

It  means the max included angle of consecutive block paths.

When  included angle of consecutive block paths of the program is larger than the Max G60 
turn angle, in-position check is always performed whether in G60 mode. This motion makes 
work piece of larger degrees no distortion and get exact acute angle, as the following figure 
(A). When the Max G60 turn angle is set to zero, in-position check isn't performed even in 
G61 mode.

Figure 3-75 (A) Included angle>the Max G60 turn angle，in-position check. (B) Included angle<the Max G60 turn 
angle，no in-position check.

Simulate Speed :

Set the simulate speed of system. It can be up to 65000 mm / min.

Network IP Address：
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Transmitting files through Internet is the specified function of  INCON-ME3. A hard disk and 
network card has been built in INCON-ME3. There is a connect RJ45 on outside of controller 
to be used to connect with a HUB. ME3 controller is a FTP server upon connecting Internet, 
and other computers connected with ME3 are clients.

Most of companies network are planned as class C. It means the first three digits are network 
name, and the last digit is the computer name. The file servers〔ME3 controller〕must be the 
same network name with other computers in a company, so that the first three digits in one 
company must be the same. The last digit is given by MIS of the company〔1 to 254〕to 
avoid unconvertible Internet by IP address conflicting .

Please ask your MIS about setting of other network class levels.

Screen Saver Delay ( minute) :

This item is used to set the delay time of screen saver. When over the setting delay time, the 
screen will be changed into a screen saver pattern with a float string,INCON-ME3. The screen 
restore the original pattern until press any key.

Note:The setting value, 0, means screen saver isn't applied.

3.4.10   Menu Item : Parameter→Save∕Load User 
Parameter

Select this menu item to open a  Save User Parameter dialog box to define the file name 
under which the user parameters is going to be saved in the MECNC document. When you 
need it one day, you can select this menu item to open a Load User Parameter dialog box to 
select a user parameter file from the MECNC document to load into the system. 
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Figure 3-76   A dialog box : Save User Parameter

3.4.11   Menu Item : Parameter→Related Machine 
Data

Select this item to open a Related Machine Data dialog box to view information of some 
related machine parameters. Users can't modify it.
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Figure 3-77  A dialog box : Related Machine Data

● Maximum Speed : Maximum speed for each axis motion.〔mm∕min〕
● G00 speed : The normal 100% G00 speed.〔mm∕min〕
● G00 0 override speed : The speed of G00 0% override is usually not the zero speed. It is 

usually a slow speed of about 500~1000 mm∕min, depends on machine.
● Jog speed : The normal 100% Jog speed.〔mm∕min〕 

● Positive∕Negative limit : Machine traverse limit for each axis, in minimum unit of the 
system.〔such as μm〕

● Maximum feed speed : Maximum feed speed for each axis. If the given F_ value 
applying feed rate overrate over this value, then the real speed will be clamped to this 
value.〔mm∕min〕

● Dry run speed : The speed for dry run 〔mm∕min〕. It  is set by 〝Machine 
Parameter→Motion and Speed→Dry Run Speed〞.

● Maximum spindle speed : The maximum speed of spindle rotation.〔rpm〕

Three lines data in the lower of this Related Machine Data dialog box shows the used time 
of this machine. The left half shows the time status from power up of current time, the right 
half shows the time status accumulated from the time of machine delivery.
● Power up Time : Accumulated power-on time of current time from power up.
● Accumulated run Time:Accumulated machining time of current time from power up.
● Duty : (Accumulated run Time)∕(Power up Time)×100%
● System life :Accumulating time of power on from machine delivery.
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● Accumulated life run Time: Accumulated machining time from machine delivery.
● System Duty : (Accumulated life run Time)∕(System Life)×100%

3.5    Help〔F2→H〕

Figure 3-79   the Help submenu

Description
T：to show a list of help topics of the system
C：to show the code listing of the system
Q：to describe a quick guide to edit and run a 
demonstration motion program
H：to describe how to use INCON-TE2 context 
sensitive help system
A：to show the copyright information and 
version number of INCON-ME3
M：to show information of this machine
L：list and print system parameters 
F：to enter key code to unlock feed lock

At any time, press F1 to open context sensitive help window, Esc to leave.

The following are key strokes for using help : 

Up∕down∕left∕right arrow keys: move around the help text   
PgUp∕PgDn: scroll up∕down one text page
Tab key: switch one cross reference topic forward  
Shift+Tab: switch one cross reference topic backward 
Enter: enter selected cross reference topic  
Esc: close help window. 
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3.5.1   Menu Item : Help→Topic Shift+F1

Select this menu item to open a help window which shows a list of help topics of the system.

Figure 3-80    a help window which shows a list of help topics of the system
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3.5.2   Menu Item : Help→Code Index  Alt+F1

Select this menu item to open a help window which shows the code listing of the system.

Figure 3-81   a help window which shows the code listing of the system
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3.5.3   Menu Item : Help→Quick Guide

Select this menu item to open a help window which describes a quick guide to edit and run a 
demonstration motion program.

Figure 3-82    a help window which describes a quick guide to edit and run a demonstration motion program
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3.5.4   Menu Item : Help→How to use help

Select this menu item to open a help window which describes how to use INCON-TE2 
context sensitive help system.

Figure 3-83  a help window which describes how to use INCON-TE2 context sensitive help system
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3.5.5    Menu Item : Help→About INCON-ME3...

Select this menu item to open a greeting window which shows the copyright information and 
version number of INCON-ME3.

Figure 3-84   A greeting window

Every INCON-ME3 has its own SERIAL number built in ME3 controller. You can look at 
SERIAL when you select 〝Help→About INCON-ME3〞.
For example:

2 2 0323 001
A B C D

A: controller,  the digit 2 means the controller is ME3.
B: year, the digits 02 means  the controller is made in 2009.
C: date, the digits 0323 means the controller is made on March 23.
D: serial  number
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3.5.6    Menu Item : Help→About Machine...

Select this menu item to open a greeting box which shows information of this machine.

Figure 3-85  a greeting box which shows information of this machine

3.5.7   List System Parameter

User parameter and machine parameter are saved by a special format. This parameter can not 
be read on normal computers directly. Select this menu item to translate user parameter and 
machine parameter into plain text format which can be read on normal computers, and 
therefore they can be printed or saved on normal computers.
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Figure 3-86  A dialog box : List System Parameters

Selecting this menu item will output〝About INCON-ME3〞, machine parameter and user 
parameter into a plain text format file, its extension name is PLS and Chinese words are 
encoded by ET code. We provide the encoder program to translate ET code into BIG5 code, 
and the program can download from Http://support.intek.com.tw .

3.5.8    Menu Item: Help→Authorisation instruction

Besides basic functions, INCON-ME3 controller provides six optional functions. The optional 
function shows in the 〝About INCON-ME3〞greeting window. For example,〝FACILITY 
: 01〞means user can save, open and run programs by USB device ;  〝FACILITY : 
02〞means user can run macro instructions. Other optional functions shows in chapter 5.

When user needs optional function and finishes business procedure,  INTEK will provide a 
authorisation instruction according to Serial and optional function. User inputs the 
authorisation codes into this dialog box 〝Authorisation Instruction〞within three days 
from codes producing.  And user will execute the optional function.
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Figure 3-87    the dialog box : Authorisation Instruction

User can get one optional function trial upon inputing trial authorisation codes by the same 
way. The difference of  the trail is period limit in minute. The remainder trial time shows in 
the dialog box 〝Authorisation Instruction〞.
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Chapter  4   Codes

4.1  Specification and definition

4.1.1   Specification

I、 Programming

● 3 axes positioning〔The 4th axis option〕
● 3 axes linear interpolation 〔The 4th axis option〕
● 2 axes angle chamfering and corner rounding 
● 2 axes circular/3-axes helical cutting 
● Absolute/incremental dimension
● Cartesian/polar system 

● Metric/inch system 

● Scaling, mirror and rotation 
● Tool radius/length compensation 
● Automatic tool length measurement 
● Canned cycles〔drilling, boring and taping〕
● Rigid tapping〔option〕
● Thread、constant surface speed and feed per revolution 

● 6 work coordinates with child coordinate 
● Inner program nest execution/ call inner subroutine / call external subprogram 

● Editor can edit capacity of parts program up to 20 M bytes
● Circular / rectangular pocket and dowel pocket 
● Circular / rectangular inner/outer side surfacing
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● Surfacing 
● Line/ matrix / arc pattern drilling 
● Object machining in line / matrix / arc pattern arrangement 

II、 Operation 

● Single block execution /optional block skip 
● Dry run/ Machine lock/ Spindle axis lock 
● MDI〔manual data input execution〕
● Manual increment / hand wheel / jogging / home operation, auto setting the program 

position 
● Feed rate override for G00 positioning speed、cutting speed and Jog speed 
● CRT graphic mode to trace tool path
● State Window updates at once

● Enlarged position counter display 
● Windows based pull down menu 
● Context sensitive help 
● Default English version, can load other language file to replace it 
● Command Insertion Aid can use table to fill in commands.
● Use dialog box input instructions and shows figures relative its instruction
● Manual aid teach-in program position for auto program generating 
● Manual feed program running in forward or backward cutting 
● Multi-hand wheel installable to operation the machine in traditional way 
● The 4th axis option
● Network connecting, can be a FTP server for up/down load CNC programs 

III、 Capacity

● Max 20 M-byte working RAM for each CNC program
● Battery memory backup RAM for all programs 
● Execute or edit programs by USB device, and transmit files from CAD work station by 

Ethernet
● ME3 is a FTP server
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4.1.2    Block definition

The program of  INCON- ME3 is similar to most of  CNC controllers. The normal program 
consists of one of four kinds of function codes 〔G, M, S, T〕and address with value 
following with function codes.

A block of CNC program is the same meaning as a line of CNC program. It consists of the 
items of the table below. Each item includes an alphabet  and some figures, which are called 
the address, number, code or value.

Nxxxx Gxx Xxxx.x Yxxx.x Zxxx.x Ixxx.x Jxxx.x Kxxx.x Pxxxx Lxxxx Rxxx.x

Sequence

Number

preparatory

function

address

& value

address

& value

address

& value

address

& value

address

& value

address

& value

address

& value

address

& value

address

& value

Fxxx.x Mxx Sxxxx Txx Enter

Feedrate 
setting 

Miscellaneous 
function 

Spindle 
Speed 

tool table 
select 

end of 
block 

The combination of the alphabet and figures will explain in the next section G-code & M-
code format later.

The values of the address could be an integer or a real number. If the value must be a real 
number but user just input an integer, the inputed value will be multiplied by least command 
increment〔least command increment means 0.001 mm in metric system, 0.0001 inch in 
imperial  system〕and input the transformed value into the controller.

For example,  in metric system, 〝X12000〞given by user, then the value will be 
transformed as 〝12〞mm〔12000 × 0.001 mm ＝12 mm〕by controller. When user desire 
to input 12 mm, must give 〝X12.〞or 〝 X12000 〞. Most users usually use 〝X12.〞 

because they consider this more convenience and save more capacity of disk. In other words, 
when  users desire 12 mm but input 〝X12〞, the actual value transformed by controller is 
0.012 mm. The difference multiple between these two values is 1000, so that crash or cutting 
over occurs then. Must keep in mind.
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ME3 controller provides the other input mode,〝Parameter→Attribute→Check 
item→[]Treat no dot as with dot〞, for users who are not used to do by the above-
mentioned method. 〝[]Treat no dot as with dot〞means whether inputed value is 
〝 X1234 〞or〝 X1234. 〞, it will be transformed as〝 X1234.000 〞by controller.

4.1.3   Program Definition

The CNC program name could be up to eight characters. The eight characters are composed 
of some of  26 alphabets〔A~Z〕 and 10 numerals 〔0~9〕. When the program is saved,  it 
will follow the extension name with 〝.CNC〞, like 〝SAMPLE.CNC〞.

SAMPLE.CNC Description

;Sample program
‘ for manual
N1 Gxx Xxxx.x Yxxx.x ;
/ Gxx Xxxx.x Yxxx.x Fxxx.x
M03 S3600;Turn on spindle in 3600rpm
N10 ... ;
...
...
M30

〝;〞: Comment

〝‘〞 : Comment

1st block

2nd block,  / : Block Skip

3rd block, with comment

4th block

......

......

End of program

● 〝;〞and 〝‘〞 : Comment
●  / : Block Skip
● 〝N1〞,〝N10〞 indicate  the line numbers, and it is not necessary to be specified in 

every line.

Next section lists the summary of  G code and M code, and will explain more detail .
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4.1.4  Axis and Coordinate Definition

We usually use X, Y,  Z to indicate the three normal axes in Cartesian coordinate system. The 
4th axis〔option〕is a rotation axis added from Cartesian coordinate system , the figure is as 
below. 

Figure 4-1   The coordinate of X, Y, Z and the 4th axis of program

The rotation axis could select one of A,B,C,U,V and W to denote its axis name.〔set 
by〝parameter→the 4th axis〞〕, the 4th axis named by A_ temporarily in the manual. Its 
value usually means rotary degrees.

Figure 4-2   A dialog box: the 4th axis named〔option〕
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4.1.5   List of G-code

Group G code Format Function

01 # G00 G00 X_Y_Z_A_; Positioning〔rapid traverse〕

# G01 G01 X_Y_Z_A_; Linear interpolation

G01 X_Y_R_; G01 for corner rounding

G01 X_Y_L_; G01 for chamfering

G02 Radius, Center and Angle  G02 CW〔Clockwise〕circular 

interpolation

G03 G03 CCW〔Counter-clockwise〕circular 

interpolation

G17 G02(G03) X_Y_R_F_;
G18 G02(G03) X_Z_R_F_;
G19 G02(G03) Y_Z_R_F_;

Radius Method

G17 G02(G03) X_Y_I_J_F_;
G18 G02(G03) X_Z_I_K_F_;
G19 G02(G03) Y_Z_J_K_F_;

Center Method

G17 G02(G03) I_J_A_F_;
G18 G02(G03) I_K_A_F_;
G19 G02(G03) J_K_A_F_;

Angle Method

00 G04 G04 P_; or G04 X_; Dwell time

G09 G09 .... One Shot Exact Stop

00 G10 G10(P_R_L_); Data setting mode on

G11 G11; Data setting mode off

17 * G15 G15; Cartesian Coordinate〔cancel G16〕

G16 G16; Polar Coordinate

02 * G17 G17; XY plane selection

G18 G18; ZX plane selection
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Group G code Format Function

G19 G19; YZ plane selection

06 ^ G20 G20; Input in imperial mode

^ G21 G21; Input in metric mode

00 G28 G28 X_Y_Z_A_; Return to Primary Reference Position by 

middle point

G29 G29 X_Y_Z_A_; Return from Target Position by middle point

G30 G30 X_Y_Z_A_P_; Return to 2nd, 3rd and 4th Reference Position 

by middle point

00 G31 G31 X_Y_Z_A_F_; Optional Skip

01 G33 G33 X_Y_Z_A_F_; Thread Cutting

00 G37 G37 Z_Q_D_F_E; Automatic tool length measurement

07 * G40 G40; Tool Radius Compensation off〔Cancel 

G41/G42〕

G41 G41; Tool Left Radius Compensation

G42 G42; Tool Right Radius Compensation

08 G43 G43; Tool Length Compensation on

* G49 G49; Tool Length Compensation off〔Cancel 

G43〕

11 & G50 G50 X_Z_;or G50 S_; Scaling/Mirror off〔Cancel G51〕

G51 G51 X_Y_Z_I_J_K_ or G51 X_Y_Z_P_ Scaling/Mirror on

00 & G52 G52 X_Y_Z_A_; Set Local〔Child〕Coordinate Offset

00 G53 G53 X_Y_Z_A_; Positioning in Machine Coordinate

14 * G54 G54; Work Coordinate System 1 Selection

G55 G55; Work Coordinate System 2 Selection

G56 G56; Work Coordinate System 3 Selection

G57 G57; Work Coordinate System 4 Selection
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Group G code Format Function

G58 G58; Work Coordinate System 5 Selection

G59 G59; Work Coordinate System 6 Selection

15 # G60 G60;  Exact Stop Mode〔In Position Check Off〕

〔Cancel  G60〕

# G61 G61; Exact Stop Mode On〔In Position Check 

On〕

16 G68 G68 X_Y_Z_R; Rotation on

* G69 G69; Rotation off〔Cancel G68〕

00 G70.00 G70.00 (G02/G03) 
P_X_Y_Z_U_V_W_C_J_K_Q_(R_/L_)D_I_E_
;

Pocket, Rectangular

G70.01 G70.01  (G02/G03) 
P_X_Y_Z_R_(U_V_W_)C_J_K_Q_I_E_F_;

Pocket, Circular

G70.02 G70.02 (G02/G03) 
P_X_Y_Z_U_V_W_A_B_C_J_K_Q_(R_/L_)D_;

Dowel, Rectangular

G70.03 G70.03 (G02/G03) 
P_X_Y_Z_R_(U_V_W_)C_J_K_Q_I_E_F_;

Dowel, Circular

G70.04 G70.04 (G02/G03) 
I_P_X_Y_Z_U_V_W_(R_/L_)D_F_;

Side Surfacing, Rectangular

G70.05 G70.05 (G02/G03) 
I_P_X_Y_Z_R_(U_V_W_)F_;

Side Surfacing, Circular

G70.06 G70.06 D_X_Y_Z_U_V_W_C_I_F_; Surfacing

G70.07 G70.07 G_X_Y_Z_R_I_J_L_Q_P_F_; Drill Pattern, Line

G70.08 G70.08 
C_G_X_Y_Z_R_I_J_A_B_U_V_W_D_Q_P_F_;

Drill Pattern, Grid

G70.09 G70.09 G_X_Y_Z_R_C_A_I_L_B_Q_P_F_; Drill Pattern, Arc

G70.10 G70.10 (G41/G42) 
P_X_Y_Z_(U_V_W_)C_J_K_Q_R_I_E_F_;

Contour Pocket
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Group G code Format Function

G70.11 G70.11 (G41/G42) 
P_X_Y_Z_(U_V_W_)C_R_I_F_;

Contour Pocket Side Surfacing

G70.21 G70.21 I_J_L_; Object Pattern, Line

G70.22 G70.22 C_I_J_A_B_D_; Object Pattern, Grid

G70.23 G70.23 X_Y_Z_R_A_I_L_; Object Pattern, Arc

09 G73 G73 X_Y_Z_R_Q_K_F_; High speed peck drilling cycle

G74 G74 X_Y_Z_R_P_K_F_; Left handed tapping cycle〔rigid tapping〕

G76 G76 X_Y_Z_R_Q_P_K_F_; Fine boring cycle

G80 G80; Turns off cancycle

G81 G81 X_Y_Z_R_K_F_; Drilling cycle, spot boring cycle

G82 G82 X_Y_Z_R_P_K_F_; Drilling cycle, counter boring cycle

G83 G83 X_Y_Z_R_Q_K_F_; Peck drilling cycle

G84 G84 X_Y_Z_R_P_K_F_; Right handed tapping cycle〔rigid tapping〕

G85 G85 X_Y_Z_R_K_F_; Boring cycle without spindle stop on the 

bottom

G86 G86 X_Y_Z_R_K_F_; Boring cycle with spindle stop on the bottom

G87 G87 X_Y_Z_R_Q_P_K_F_; Back boring cycle

G88 G88 X_Y_Z_R_P_K_F_; Boring cycle which allows manual motion 

from the bottom

G89 G89 X_Y_Z_R_P_K_F_; Boring cycle with dwelling on the bottom

03 # G90 G90; Absolute dimension

# G91 G91; Incremental dimension

00 & G92 G92 X_Y_Z_A_;
G92;

Set absolute zero point

G92 External Offset

05 G94 G94; Feed per Minute

G95 G95; Feed per Revolution
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Group G code Format Function

13 G96 G96; Constant Surface Speed Control on

* G97 G97; Constant Surface Speed Control off〔Cancel 

G96〕

05 G98 G98; Return to initial position in cancycle

* G99 G99; Return to reference position in cancycle

4.1.6   In Groups

Class A: Status change

03 06

# G90 Absolute dimension ^ G20 Input in imperial mode

# G91 Incremental dimension ^ G21 Input in metric mode

02 07

* G17 XY plane selection * G40 Tool Radius Compensation off

G18 ZX plane selection G41 Tool Left Radius Compensation

G19 YZ plane selection G42 Tool Right Radius Compensation

17 08

* G15 Cartesian Coordinate〔cancel G16〕 G43 Tool Length Compensation on

G16 Polar Coordinate * G49 Tool Length Compensation off〔Cancel G43〕

124



Chapter  4   Codes 

11 16

* G50 Scaling/Mirror off〔Cancel G51〕 G68 Rotation on

G51 Scaling/Mirror on G69 Rotation off〔Cancel G68〕

05 10

* G94 Feed per Minute * G98 Return to initial position in cancycle

G95 Feed per Revolution G99 Return to reference position in cancycle

14 13

* G54 Work Coordinate System 1 Selection G96 Constant Surface Speed Control on

G55 Work Coordinate System 2 Selection G97 Constant Surface Speed Control off〔Cancel 

G96〕

G56 Work Coordinate System 3 Selection

G57 Work Coordinate System 4 Selection 15

G58 Work Coordinate System 5 Selection G60  Exact Stop Mode〔In Position Check Off〕

〔Cancel  G60〕

G59 Work Coordinate System 6 Selection G61 Exact Stop Mode On〔In Position Check On〕

Class B: Motion

01

# G00 Positioning〔rapid traverse〕

# G01 Linear interpolation

G02 G02 CW circular interpolation

G03 G03 CCW circular interpolation

G33 Thread Cutting

G31 Optional Skip
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00 09

G10 Data setting mode on G73 High speed peck drilling cycle

G11 Data setting mode off G74 Left handed tapping cycle〔rigid tapping〕

G28 Return to Primary Reference Position by 

middle point

G76 Fine boring cycle

G29 Return from Target Position by middle point G80 Turns off cancycle

G30 Return to 2nd, 3rd and 4th Reference Position by 

middle point

G81 Drilling cycle, spot boring cycle

G53 Positioning in machine coordinate G82 Drilling cycle, counter boring cycle

G37 Automatic tool length measurement G83 Peck drilling cycle

G70.00 Pocket, Rectangular G84 Right handed tapping cycle〔rigid tapping〕

G70.01 Pocket, Circular G85 Boring cycle without spindle stop on the 

bottom

G70.02 Dowel, Rectangular G86 Boring cycle with spindle stop on the bottom

G70.03 Dowel, Circular G87 Back boring cycle

G70.04 Side Surfacing, Rectangular G88 Boring cycle which allows manual motion 

from the bottom

G70.05 Side Surfacing, Circular

G70.06 Surfacing

G70.07 Drill Pattern, Line

G70.08 Drill Pattern, Grid

G70.09 Drill Pattern, Arc

G70.10 Contour Pocket

G70.11 Contour Pocket Side Surfacing

G70.21 Object Pattern, Line

G70.22 Object Pattern, Grid

G70.23 Object Pattern, Arc
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Class C: One shot commands

00

G04 Dwell time

G09 One Shot Exact Stop

& G52 Set Local〔Child〕Coordinate Offset

& G92 Set absolute zero point G92 External Offset

Note:

1. About the marks:
* : initial G-code in the group upon power on.
# : initial G-code which could be selected by parameter setting.
^ : the G-code will be memorized when system is shut down.
& : keep effective until program ends or is changed again.

2. When the machine stops in an emergency or press key F10 to abort the execution, the tool 
radius compensation will be canceled automatically. For example:

Group 07 G40/G41/G42, the default code is G40〔Tool Radius Compensation off〕
Group 11 G50/G51, the default code is G50〔Scaling/Mirror off〕
Group 16 G68/G69, the default code is G69〔Rotation off〕
Group 17 G15/G16, the default code is G15〔Cartesian Coordinate〕

When program executes normally even the default code of the above-mentioned groups 
were not given,  the above-mentioned groups will restore the default codes.

3. The 〝one shot G code〞 is only effective in the specified block. These one shot G codes 
are all classified to group 00. The others G code are mode, and these mode G code will be 
kept effective until the other G code of the same group appearing and replacing it.

4. Three different G codes of class A〔Status change G codes〕allow in the same block 
CNC program at the same time.
For example: G18  G91  G16;
〔The three are all status-change G codes.〕
Only one motion G-code allow in a block, but two different Status-change G codes can be 
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in the same block. Two of the Status-change G codes  are before one of motion G codes.
For example: G54 G90 G01 X600. Y400; 
〔G54 and G90 are status change G codes; G01 is the motion G code.〕

5. The one shot G code can only exist alone. No other G codes can exist simultaneously in 
the same block.

6. G90 must exist with motion G-codes in the same line of a program, for example, 
G09 G01 X500. Y450.;

4.2   Positioning & Feed 
instructions

4.2.1  G00∕G53：Positioning∕Positioning in 
Machine Coordinate

Format： 

G00 X_Y_Z_A_;
G53 X_Y_Z_A_;

Command the tool move to the specified target position X_Y_Z_A_ rapidly. The positioning 
speed is set by 〝Machine parameter→Axis→X〔Y or Z〕axis→G00 speed〞multiplied 
the rate of G00 speed override. G00 speed override is operated by rotary switch on GMPU.

The moving without cutting usually is programmed by G00 instruction to save cutting time. 
The motions are such as positioning from machine origin to cutting start point, retract tool of 
Z axis upon finishing cutting, positioning of X or Y axis and so on. 

G00 mode can position with three axes simultaneously, two axes simultaneously or single 
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axis. The setting is set by〝Machine Parameter→Motion and Speed→G00 mode〞. When 
you desire to change G00 mode, please ask your machine maker for service.  

Figure4-3   G00 position with two axes simultaneously   Figure4-4  G00 position with three axes simultaneously

G53 moves the tool to the specified target position  rapidly like G00, and G53 is specified by 
the absolute machine coordinate value.

G53 is an One-shot G-code, therefore it is only effective in the block of  G53 specified. This 
command G53 is only effective in the absolute mode. If  it is programmed with G53 U_ 
W_ , the program will alarm error message.

Note: G00/G53 are not relatived with G17/G18/G19 plane selection.

4.2.2   G01：Linear Interpolation

4.2.2.1   Normal Linear interpolation

Format：

G01 X_Y_Z_A_F_;

When the counter of work piece is straight line, cut it by G01 instruction. The position 
X_Y_Z_A_ denotes end position of cutting. It can cut with three axes simultaneously,  two 
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axes simultaneously or signal axis. The F_ value is specified by the feed speed which is 
adjusted by the rate of feed rate override operated by rotary switch on GMPU.

The unit specified G94〔mm∕min〕of F_  is different from G95〔mm∕rev〕. F_ is a 
sustaining command, so it doesn't need to be specified again when the feed speed is the same 
as one in the current block.

For example, under G95 mode, the feed distance of   F0.1 S3000 is 
0.1〔mm∕rev〕 ×  3000〔rev∕min〕= 300 〔mm∕min〕

Figure4-5  G01 linear interpolation with two axes               Figure 4-6  G01 linear interpolation with three axes 

Note: As for linear interpolation with two axes, G01 is not related to G17/G18/G19 plan 
selection; when execute chamfering or  corner rounding, G01 is related to G17/G18/G19 
plan selection.

4.2.2.2   Chamfering or  Corner Rounding

Format：

G01 X_Y_L_;
G01 X_Y_R_;

Chamfering or corner rounding just executes on a special plane, and its current command and 
next command both must be G01.

Chamfering will add a chamfering command to the corner at the distance L_ from the corner 
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and make the corner not so sharp.

Figure 4-7  Chamfering                                                        Figure 4-8  Corner Rounding

Corner rounding means add a arc command with the radius R_ automatically at intersection 
of two straight lines. It makes two lines tangent with straight line respectively and generate a 
corner rounding instead of chip.

Note: the length of chamfering 〔L_〕 or the radius of corner rounding 〔R_〕must be less 
than the length of both commands.

4.2.2.3   Direct drawing dimensions programming

Angles of straight lines, chamfering value, corner rounding values, and other dimensional 
values on machining drawings can be programmed by direct input of these values. In addition, 
the chamfering and corner rounding can be inserted between straight lines having an optional 
angle.

Example 1：

131



 INCON-ME3 CNC Controller Guide of Milling

Figure 4-9  Input the angle between lines

X(x2) Z(z2) ,C(c2);
X(x3) Z(z3) ,R(r2);
X(x4) Z(z4);

or A(a1) C(c1);
X(x3) Z(z3) A(a2) ,R(r2);
X(x4) Z(z4);

Note: To command a straight line, specify one or two out of  X_, Z_, and A_. If only one is 
specified, the straight line must be primarily defined by a command in the next block.

Instruction table 

Instruction table Tool path

1. X2____( Z2____)A____;

2. A1____;
X3____ Z3____A2____;
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Instruction table Tool path

3. X2____ Z2____R1____;
X3____ Z3____;
or
A1____ R1____;
X3____ Z3____ A2____;

4. X2____ Z2____C1____;
X3____ Z3____;
or
A1____ C1____;
X3____ Z3____ A2____;

5. X2____ Z2____R1____;
X3____ Z3____R2_____;
X4____ Z4;
or
A1____ R1____;
X3____ Z3____ A____ 
R2_____;
X4____ Z4;

6. X2____ Z2____C1____;
X3____ Z3____C2_____;
X4____ Z4;
or
A1____ C1____;
X3____ Z3____ A2____ 
C2_____;
X4____ Z4;
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Instruction table Tool path

7. X2____ Z2____R1____;
X3____ Z3____C2_____;
X4____ Z4;
or
A1____ R1____;
X3____ Z3____ A2____ 
C2_____;
X4____ Z4;

8. X2____ Z2____C1____;
X3____ Z3____R2_____;
X4____ Z4;
or
A1____ C1____;
X3____ Z3____ A2____ 
R2_____;
X4____ Z4;
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Example 2：Program by  the metric system in the diameter mode

Figure 4-10  Program by  the metric system in the diameter mode

N001 G50 X0.0 Z0.0
N002 G01 X60.0 A90.0 C1.0 F80;
N003 Z-30.0 A180.0 R6.0;
N004 X100.0 A90.0
N005 A170.0 R20.0
N006 X300.0 Z-180.0 A112.0 R15.0;
N007 Z-230.0 A180.0;
                       .
                      .
                      .
                      . 

4.2.3   G31：Optional Skip

Format：

G31 X_ Y_ Z_ A_ F_;
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G31 executes linear interpolation with specified feed rate. The feed speed is specified by F_. 
The end position is specified by X_ Y_ Z_ A_. The feed speed can be adjusted by the rate 
of feed speed override. 

However, when an optional skip input signal is on from PLC, the instruction will skip the rest 
of the process and stop right away. For example: 

G31 X100. Y100. Z100. A100. F100.
The instruction means the machine moves to (100.,100.,100.,100.)with the speed 
100 mm∕mm. If the machine moves at (X80.,Y80.,Z80.,A80.)and an optional skip 
input signal is on from PLC, the instruction will skip the rest of the process and stop at 
(X80.,Y80.,Z80.,A80.) right away. 

4.2.4  G02/G03：: CW/CCW Circular

4.2.4.1   Definition of G02/G03

G02: CW〔Clockwise〕 Circular Interpolation
This code executes clockwise circular interpolation.

G03: CCW〔Counter-clockwise〕Circular Interpolation
This code executes counter-clockwise circular interpolation.

The arc contour of work piece is programmed by G02 or G03 instruction. Because work 
piece of miler is 3D, the figures of G02 or G03 on different plane shows as bellow. The 
definition denotes look at the specified plane from positive to negative direction along normal 
axis, clockwise is G02 but counter clockwise is G03. The arc path differs from selected 
planes, so G17/G18/G19 must be specified before G02/G03.
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Figure 4-11   The relation of the arc direction and selected plane

1. G02/G03 in 2D motion

Figure 4-12   G02/G03 in 2D motion

2. G02/G03 in 3D motion

Figure 4-13   G02/G03 in 3D motion〔The figure example is under G02〕
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4.2.4.2    Format of G02/G03

There are three types of format in G02/G03:

2D 〔Arc or circle〕 3D 〔Helical〕

Radius
G17 G02(G03) X_Y_R_F_;
G18 G02(G03) X_Z_R_F_;
G19 G02(G03) Y_Z_R_F_;

G17 G02(G03) X_Y_R_Z_F_;
G18 G02(G03) X_Z_R_Y_F_;
G19 G02(G03) Y_Z_R_X_F_;

Center
G17 G02(G03) X_Y_I_J_F_;
G18 G02(G03) X_Z_I_K_F_;
G19 G02(G03) Y_Z_J_K_F_;

G17 G02(G03) X_Y_I_J_Z_F_;
G18 G02(G03) X_Z_I_K_Y_F_;
G19 G02(G03) Y_Z_J_K_X_F_;

Angle
G17 G02(G03) I_J_A_F_;
G18 G02(G03) I_K_A_F_;
G19 G02(G03) J_K_A_F_;

G17 G02(G03) I_J_A_Z_F_;
G18 G02(G03) I_K_A_Y_F_;
G19 G02(G03) J_K_A_X_F_;

I. Radius Mode:

A.  Normal mode: 

1. When the code R_ exists, this mode has the highest priority. 
2. Define the end position by the code X_ Z_ and the radius by the code R_. 
3. When  R_ is negative, the arc of  greater than 180 degree will be executed.

Format：G18 G02(G03) X_Z_R_; 

Figure 4-14  normal tool path in radius mode
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B. When d > 2R: 

1. When a radius is less than half of the distance between starting position and end position, 
a semicircle of the radius R_ is executed first.

2. The rest of the distance is executed like the mode G01. 
3. The G02 mode still keeps effective.

Format: G18 G02(G03) X_Y_R_;

Figure 4-15  tool path in radius mode when d > 2R

C.    When R= 0 : When at least one of  X_,Z_ exists and the code R_ equals to zero, G02 is 
executed like G01. 

Figure 4-16   Format: G02(G03) X_Y_Z_R0; or X_Y_Z_;

D.   When X_,Y_,Z_ and R_ are gone, no motion in the block.

II. Center Mode:

A. Normal mode: 

1. Define the end position by X_,Z_ and the center by the codes I_,K_. 
2. The actual arc of  the center I_,K_ is not sure located  on  the end position  X_,Z_. 
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3. To be located on  the end position X_,Z_, the center and the radius of the arc will be 
calculated again.

4. The new radius R' is the average of  from the original center to start point and to end 
point.

Finally, the Center Mode will switch to the Radius Mode with the new radius R'.

Note：〝e〞is the distance from end point to  the center。

Figure 4-13  Format：G02(G03)X_Z_I_K_F_; (A)Normal mode。(B)When e > R時。(C)When e < R時。 

B. When  X_,Y_,Z_ are gone, a full circle of the center I_,J_,K_ is executed.

Figure 4-18  G18 G02(G03) I_K_;

When  X_,Y_,Z_ exists, and the codes I_,J_,K_ are all zero, the center mode is executed 
like G01.
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Figure 4-19  G02(G03)X_Y_Z_I0 J0 K0; or G02(G03) X_Y_Z_;

III. Angle mode

A.   Normal mode: 

1. If no X_,Y_,Z_ exists, and A _ is commanded.
2. Define commanded position by A_, and center by I_,J_,K_ codes.

Format：G90 G18 G02(G03) I_K_A_;          Format：G91 G18 G02(G03) I_K_A_;

Figure 4-20  Angle mode. (A) Absolute format  (B) Incremental format.

If A_ code equals to zero under absolute mode, the motion is as below.

Figure 4-21   When A_ code equals to zero under absolute mode

If I_,J_,K_  codes all equals to zero, no motion for the section.

If I_J_K_ codes all equals to zero or A_ code equals zero under increment mode, no motion 
for the section. 
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4.2.5  G33：Thread Cutting

Format：

 G33 X_Y_Z_A_F_;

G33 works with G95 at the same time. G95 set the feedrate per revolution by the code F_ , 
and make  tools do surface cutting according to the rate of the spindle shifting the distance F_ 
per revolution in X ,Y ,Z or A axis.  The difference of  G33 and G01 is that G33 lead thread 
cutting with start angle specified by  A _.That is all the reason why G33 can thread cutting.

Note：G95 must be specified previously to the G33 command. And the spindle should have 
implemented the encode in order to do the synchronous control.

Figure 4-22   G33：Thread Cutting

Figure 4-23   G33 X_Z_F_

Note: The dotted line of the coming back is added by G00, but not included by G33.
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4.3   Tool Compensation 
Instructions

4.3.1  G43/G49：Tool Length Compensation 
on∕off

Format：

G43 H_;
G49;

G43 initializes the tool length compensation.

The sign and value of tool length in the tool table decides the +/- direction and length of the 
compensation in 3rd axis 〔for example, Z axis in G17〕.
G49 cancels the tool length compensation, and restores to normal condition in 3rd axis.

Figure 4-24  Tool length compensation

143



 INCON-ME3 CNC Controller Guide of Milling

4.3.2   G37：Automatic tool length measuring

Format：

G37 Z_ Q_ D_ F_ E_;

where
    desired machine position : defined by Z_〔G37〕
    probe retract distance : defined by Q_
    probe detect distance : defined by D_
    probe searching speed : defined by F_
    probe detect speed : defined by E_

G37 performs automatic tool measurement. It moves the tool towards measurement device in 
probe search speed until probe is detected. Then moves backward until the tool leaves the 
measurement surface. The tool is then retracted in search speed by retract distance. After that, 
probe moves toward the measurement device again in detect speed until probe is
detected again. After all these process, the difference between the desired machine position 
and the current machine position is set into the current tool table entry automatically.

Before uses the G37 command, make sure:

1. The machine tool has implemented the tool measurement sensor〔probe〕
2. H_ value has been specified before giving the G37 command.(This H_ value can not be 

H00〕
3. The tool is to be measurement, has been moved to the upper place of the sensor.

The following procedure of tool measurement will be performed automatically:

1. At beginning, the tool moves in middle speed〔F_ value〕to approach the sensor, until 
the tool tip touched the sensor. If exceeding D_ distance and no touch the sensor, an alarm 
will be popped out and abort the tool measurement.

2. If the tool tip touches the sensor within D_ distance, then it will retract Q_ distance in F_ 
speed.

3. And then use very low speed〔E_ value〕to approach and to touch the sensor again. As 
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soon as the tool tip touches the sensor, the motion stops. 
4. Read the current spindle axis value〔absolute position〕, and then calculate the 

difference from the expected value. Add this difference value to the respective length item 
〔specified by H_〕in the tool table, to make the current tool tip position to match the 
expected value.

Note:

1. If  Z code does not exist, X/Z=0 is assumed.
Other codes〔Q_ D_ F_ E_〕can use the value defined in  Z tool length measurement 
of user parameter.

2. The searching direction is negative if Q_ value is positive.

Figure 4-25  Automatic tool offset measurement  
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4.3.3   G40/G41/G42：Tool Radius 
Compensation off / on

Format：

G41 D_;
G42 D_;
G40;

G40: Tool Radius Compensation off

G40 turns off tool nose compensation, the next motion command following G40 has to be a 
G00 or G01 to transit out of the nose compensation mode.

G41: Left Tool Radius Compensation

G41 turns on tool nose compensation along the left side of the original profile path. The tool 
radius used is the value stored in tool table of the current tool offset number. The motion 
codes between G41 and G40 must be G01, G02 or G03.

G42: Right Tool Radius Compensation

G42 turns on tool nose compensation along the right side of the original profile path. The tool 
radius used is the value stored in tool table of the current tool offset number. The motion 
codes between G42 and G40 must be G01, G02 or G03.
The address D_ is a tool number of the tool table. The tool number D_ can be specified before 
the command G41/G42, and it keeps effective until the next new tool number D_ is 
executed. The tool number D00 means no compensation 〔the radius is zero〕. 

G40 cancels the tool radius compensation〔transit out〕 , and restores to the normal tool 
path. The new tool nose is very sharp with an angle 〔as shown in the left figure〕. It 
becomes  round after a period of cutting〔as shown in the right figure〕.

This system follows the following rules to execute tool radius compensation in the mode :
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A. When the angle to the compensated side between two continuous blocks is larger than 180 
degree, this system inserts an arc between the two block motion.

Figure 4-26    the tool compensation inserts an arc between the two block motion

2. When the angle to the compensated side between two continuous blocks is smaller than 
180 degree, this system calculates the intersection of the two paths automatically. This 
intersection point becomes the end point of the first block motion and the start point of the 
second block motion.

Figure 4-27   the tool compensation inserts an intersection point between the two block motion

Note:

1. Linear Interpolation〔G01〕must be used when tool transits into or out the 
compensation. Use circular interpolation 〔G02/G03〕at the same time,  the machine 
will alarm and turn off  automatically.

2. To change of radius , exchange from G41 to G42 or exchange from G42 to G41 is not 
allowed in the tool compensation mode. A full circle format of  G02/G03 can't be 
executed in G41/G42 mode.
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4.3.3.1   Transit into the compensation〔G41/G42 begins 
compensating〕

Must enable compensation at the last block before transiting into the compensation. When 
transit compensation into target position, the tool will shift left / right the distance of a radius. 
In the following figures, the broken line denotes compensated tool path, but the straight line 
denotes original programmed tool path. 

Figure 4-28  Transit into the compensation〔G41/G42 begins compensating〕

148



Chapter  4   Codes 

4.3.3.2   In the compensation mode

1. From straight line to straight line

Figure 4-29  In the compensation mode: From straight line to straight line

2. From straight line to arc

(1)  From straight line to CW arc

Figure 4-30  In the compensation mode: From straight line to CW arc

149



 INCON-ME3 CNC Controller Guide of Milling

(2)  From straight line to CCW arc

Figure 4-31  In the compensation mode: From straight line to CCW arc

3. From arc to arc

(1)  From CW arc to CW arc

Figure 4-32  In the compensation mode: From CW arc to CW arc

(2)   From CW arc to CCW arc

Figure 4-33  In the compensation mode: From CW arc to CCW arc
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(3)   From CCW arc to CCW arc

Figure 4-34  In the compensation mode: From CCW arc to CCW arc
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4.3.3.3   Transit out the compensation〔G40 finishes 
compensating〕

Upon finishing compensation, the tool will return to the original programmed tool path.

Figure 4-35  Transit out the compensation〔G40 finishes compensating〕
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4.4   Cancycles Instructions

4.4.1 G98/G99：return to initial position 
∕reference position in cancycle

Format：

G98; return to initial position in cancycle
G99; return to reference position in cancycle

Can Cycle instructions can execute drilling, boring and tapping. All the motions of these 
instructions are similar, as the following two figures:

Figure 4-36  G98  returns to initial position in cancycle   Figure 4-37  G99 returns to reference position in cancycle

The left figure G98 denotes the tool returns to initial position upon finishing; the right figure 
G99 denotes the tool returns to reference position upon finishing.

These cancycle instructions give the cutting mode of the first hole, the following holes just 
give their cutting positions, and then they will do repeating motions until G80 cancel 
cancycle. The Class A G-codes , such as G00/G01/G02/G03/G33, occurring is treated as 
cancycle cancel.
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As for reference position in cancycle instructions, R_ denotes the value of reference position 
under G90, absolute dimension. Under G91, increment dimension, R_ denotes the distance 
from initial position to reference position, and the value of  R_ is always positive.

As for drilling depth Z_ specified by G90/G91: Z_ denotes the value of drilling depth under 
G90, but Z_ denotes the increment distance from reference position to drilling depth under 
G91 and the distance could be positive or negative.

The motions of above-mentioned commands are specified respectively by G90/G91 and the 
figures is as below:

Figure 4-38  G90                                            Figure 4-39  G91

In addition, all cancycle instructions can give K_ to repeat the specified cancycle instruction 
K_ times alone a straight  or tile line, such as Line Drill Pattern.

For example, “G91 Gxx Xdx Ydy Z_ R_ F_ Kk; ”means repeat to execute some 
cancycle instruction Gxx 〔G73~G89〕k_ times,  dx and dy denotes respectively the 
interval between consecutive holes of X and Y axis. The instruction repeats cancycle along a 
straight or tile line makes cutting more convenient.

Figure 4-40   Repeat cancycle under G91 mode
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Note: K_ is nonsense under G90 mode, because it will repeat cancycle at the same hole.

Some of cancycle instructions, such as G74,G76,G82,G84,G87,G88 and G89, can give 
P_ to dwell P_ seconds at the drilling depth Z_. This commands can make the drilling depth 
more precise or make the spindle having buffer time to reverse. 

Figure 4-41  Dwell P_ seconds at the drilling depth Z_

4.4.2  G80：Turns off cancycle

Format：

G80;

Because cancycle instructions functions are sustained, don't  specify again in every block 
when executing the same cancycle instruction. When finishing cancycle and don't execute it 
anymore, must specify G80 to cancel cancycle and restore normal mode, such as G00, G01, 
G02 and G03. 
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4.4.3   G81/G82, G73/G83：Drilling Cycle

Format：

G81 X_Y_Z_R_K_F_;
G82 X_Y_Z_R_P_K_F_;
G73 X_Y_Z_R_Q_K_F_;
G83 X_Y_Z_R_Q_K_F_;

G81： drilling cycle, spot boring cycle
G82： drilling cycle, counter boring cycle

G81/G82 is a simple drilling, it can drill to the bottom once. Execute the simple boring 
sometimes by G81/G82. Executing G81/G82 motions show as the following figure:

1. Move the drill rapidly to position specified by X and Y axis.
2. Position 〔G00〕to reference position R_.
3. Drill to the bottom Z_ of specified hole with the specified feed speed F_.
4. Retract the drill rapidly to initial position〔G98〕or reference position〔G99〕to finish 

cancycle.

Note: Straight line denotes feed speed F_ and broken line denotes G00 speed in the following 
figures. 

Figure 4-42  G81  ： drilling cycle, spot boring cycle

Besides pause P_ seconds in the bottom of specified hole, other motions of G82 are the same 
as ones of G81. G82 makes the drill pause  P_ seconds in the bottom of specified hole to 
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improve the precision of bottom of blind hole, beam hole and taper hole.

Figure 4-43  G82  ： drilling cycle, counter boring cycle

G73：high speed peck drilling cycle 
G83：peck drilling cycle

G73/G83 is a complex drilling, it can peak section by section  instead of drilling to the 
bottom once. Every section motion can retract the tool and remove from filings.   

The motion of G73 shows as the following figures :

1. Move the drill rapidly to position specified by X and Y axis.
2. Position 〔G00〕to reference position R_.
3. Drill the specified distance Q_〔Q_ is always a positive value〕along Z axis with the 

specified feed speed F_.
4. Retract the drill back in a distance d rapidly. 
5. Repeat Step 3. ~ Step 4. once and once until reach to the specified bottom position Z_.

The interval drilling make filings broken and cutting oil reach to the contour easily. 

Only retract a fixed distance d which is set by 〝Parameter→Cancycle Parameters〞when 
retract tool and remove from filings under G73 mode.
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Figure 4-44  G73：high speed peck drilling cycle 

The motions of G83 are similar to ones of G73. The difference between G83 and G73 is that 
retract tool to reference position R_ under G83 mode. This motion can remove the filings out 
of hole and avoid the hole full of filings to increase cutting resistance or make cutting oil not 
reach to the contour. This is the reason why G83 is suited to deep hole drilling.  

Figure 4-45  G83：peck drilling cycle
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4.4.4   G85/G86、G76/G87、G88、G89：boring 
cycle

Format：

G85 X_Y_Z_R_K_F_;
G86 X_Y_Z_R_K_F_;
G76 X_Y_Z_R_Q_P_K_F_;
G87 X_Y_Z_R_Q_P_K_F_;
G88 X_Y_Z_R_P_K_F_;
G89 X_Y_Z_R_P_K_F_;

4.4.4.1  G85/G86：boring cycle without / with spindle stop 
on the bottom

The motion of G85 shows as the following figures :

1. Move the reamer rapidly to position specified by X and Y axis.
2. Position 〔G00〕to reference position R_.
3. Ream downward to the specified position Z_ in the bottom of specified hole with the 

specified feed speed F_.
4. Retract the reamer back with feed speed F_. This is the reason why G85 is suited to 

reaming.

Figure 4-46   G85: boring cycle without spindle stop on the bottom
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Stop the spindle upon the reamer reams at the cutting depth Z_, retract to initial position 
〔G98〕or reference position〔G99〕, and then restore the spindle clockwise〔CW〕.

Figure 4-47  G86: boring cycle with spindle stop on the bottom

4.4.4.2   G76/G87：Fine Boring Cycle∕Back Boring Cycle

Both G76 and G87 execute the motion which is stopping the spindle at the specified 
direction. That is the reason why G76 and G83 can do fine boring.

The motion of G76 shows as the following figures :

1. Move the boring cutter rapidly to position X_,Y_.
2. Position 〔G00〕to reference position R_.
3. Bore downward to the specified position Z_ in the bottom of specified hole with the 

specified feed speed F_ .
4. Stop the spindle toward a specified direction.
5. The center of the boring cutter toward a specified direction shift a little distance Q_, and 

make the boring cutter leave the cutting contour. 
6. Retract the boring cutter back to initial position〔G98〕or reference position 

〔G99〕with G00 speed. Step 5.~Step 6. protects the cutting contour from scraping.
7. Position the boring cutter to position X_,Y_ and restore the spindle clockwise〔CW〕. 

Note: the shift value Q_ must be positive and can't be too large to crash work piece.
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Figure 4-48   G76: fine boring cycle

The motion of G87 shows as the following figures :

1. Move the boring cutter rapidly to position X_,Y_.
2. Stop the spindle toward a specified direction.
3. The center of the boring cutter toward a specified direction shift a few distance Q_,  make 

the boring cutter leave the cutting contour and move the boring cutter downward. This 
protects the cutting contour from scraping.

4. Position 〔G00〕to reference position R_ on the bottom of hole. 
5. Shift the distance Q_ toward original direction and restore the spindle clockwise〔CW〕.
6. Bore upward to the specified position Z_ with the specified feed speed F_ .
7. Stop the spindle and make the boring cutter leave the cutting contour a few distance Q_.
8. Retract the boring cutter back to initial level.
9. Shift the distance Q_ toward original direction and go back to initial position X_Y_. That 

is all  motions of G87.
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Figure 4-49   G87: back boring cycle

Note: in G87, the definitions of reference level R_ and programmed depth Z_ are different 
from ones of other cancycle instructions. The reference level R_ locates at the lowest position 
whereas the programmed depth Z_ locates above the R_ level. Due to this fact, G87 cannot 
be programmed in G99 mode. 

4.4.4.3   G88：boring cycle which allows manual motion 
from the bottom

Under G88 mode, when boring to the programmed depth Z_, stop the spindle P_ seconds 
temporarily. Then, enable manual mode to make tool back to reference position R_ and leave 
manual mode by 2nd operating panel. If tool doesn't reach over the reference position R_, the 
alarm dialog box will pop up and can't allow to leave manual mode.

Note: Upon making sure the tool position has been over reference position R_, restore the 
spindle clockwise〔CW〕.For safety, please keep in mind to let head and hands far to 
spindle. If G88 is programmed by G98 dimension, tool will continue upward to initial level, 
but by G99 dimension tool will not move anymore.  The finish position doesn't restore to the 
position specified by G88.
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Figure 4-50  G88: boring cycle which allows manual motion from the bottom

4.4.4.4   G89： boring cycle with dwelling on the bottom

Under G89 mode, when boring to the programmed depth Z_, stop the spindle P_ seconds 
temporarily. Then, spindle upward to reference level R_ with feed speed F_. If G89 is 
programmed by G98 dimension, tool will continue upward to initial level, but by G99 
dimension tool will not move anymore. 

Figure 4-51   G89: boring cycle with dwelling on the bottom
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4.4.5   G74/G84：Rigid Tapping Cycle

Format：

G74 X_Y_Z_R_P_K_F_; left handed tapping cycle〔rigid tapping〕
G84 X_Y_Z_R_P_K_F_; right handed tapping cycle〔rigid tapping〕

G74 specify left handed tapping cycle. Must make spindle CCW〔M04〕first and then 
execute G74. 

The motions of G74 are as below:

1. Position tool to the specified position X_,Y_ first.
2. Position tool downward to reference level R_.
3. Tapping to the specified position Z_ on the bottom with feed speed F_. 
4. Reverse the spindle CW and back to reference level R_ along the positive direction of Z 

axis.
5. Restore the spindle CCW at the reference level R_.

Figure 4-52   G74 left handed tapping cycle〔rigid tapping〕

G84 specify right handed tapping cycle. Must make spindle CW〔M03〕first and then 
execute G84. 

The motions of G84 are as below:

1. Position tool to the specified position X_,Y_ first.
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2. Position tool downward to reference level R_.
3. Tapping to the specified position Z_ on the bottom with feed speed F_. 
4. Reverse the spindle CCW and back to reference level R_ along the positive direction of Z 

axis.
5. Restore the spindle CW at the reference level R_.

Figure 4-53   G84 right handed tapping cycle〔rigid tapping〕

4.4.5.1    Rigid Tapping

INCON-ME3 controller features rigid tapping if the machine uses variable speed spindle 
driver and mounts an encoder on the spindle for spindle orientation angle detection. Use 
specific M code to turn on rigid tapping. It is usually M29. Format is M29 Sxxxx.

When use AC motor instead of spindle driver, the depth of the tapping will be a little distance 
over-tapped or short-tapped. The over∕short-tapped distance will depend on the speed 
performance of the  AC motor and the machine parameter setting of the spindle related about 
tapping. Ask your CNC machine maker about this situation.

Format：

M29 S_;
M03
G84 X_Z_R_F_;
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Before performing the rigid tapping, the M29 S_; command must be specified previously, in 
order to set the rotation speed and enable the rigid tapping mode. This rotation speed of 
tapping is usually in low speed. And this speed will be clamped by the setting of rigid tap 
maximum speed in machine parameter.

This M29 S_ ; command will be kept effective until tapping cycle cancels. 

If the spindle has implemented the high∕low speed gear change, before doing the rigid 
tapping, make sure that the gear change should be switched to the dedicated gear for rigid 
tapping to work with spindle rate ratio. We can get the correct tapping pitch. No gear change 
needs no change the gear.

The tapping pitch in rigid tapping can be calculated in G94 or G95 mode, as follows:

1. The lead of the tap is equal to F_ code value divided by S_ code value if system is in G94 
mode.

Example: If F=100 mm∕min, S=200 rpm, and then the pitch =100∕200=0.5 mm.

The program can be as follows:

G90 G0 X0 Y0 Z0 ; move tool to part center and cutting point in Z direction
G49 G54 G94 ; Select G94 mode
M29 S200 ; Enable rigid tapping, S=200 rpm
M03 ; Turn on spindle in CCW rotation
G84 X0 Y0 Z-10. F100 ; Do tapping in 100∕200=0.5 mm lead, 10 mm depth 
G80 ; Turn off cancycle and rigid tapping
M30

2. The lead is equal to F_ code value if system is in G95 mode.
Example: If F=3 mm∕rev, then the pitch =F=3 mm, no matter what rpm will be. 
The F_ value can be less then 1 mm, therefore it is very convenience to use the rigid 
tapping in G95 mode.

The program can be as follows:
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G90 G0 X0 Y0 Z0 ; move tool to part center and cutting point in Z direction
G49 G54 G95 ; Select G95 mode
M29 S200 ; Enable rigid tapping, S=200 rpm
M03 ; Turn on spindle in CW rotation
G84 X0 Y0 Z-10. F0.5 ; Do tapping in 0.5 mm lead, 10 mm depth
G80 ; Turn off cancycle and rigid tapping
M30

Where〝G84 X0 Y0 Z-10. F0.5〞figures out the 0.5 mm lead directly. And make the 
program more readable.

4.5   Rotation, Mirrorand Scaling 
Instructions 

4.5.1  G68/G69：Rotation on∕off

Format：

G68 X_Y_Z_R_;
G69;

G68 enables system to rotate coordinate. In the case of absolute dimension〔G90〕, the 
center of rotation is defined by two axes among X, Y, or Z corresponding to which of G17, 
G18, or G19 is  specified.

The angle of rotation is defined by R_. The sign〝+〞and〝-〞in front of R_ value denotes 
CCW or CW rotation. For angle, Absolute or Incremental is set by a 〝Parameter→Rotation 
angle...→Rotation Angle Abs / Inc〞.
If selected 〝(●) Incremental〞, the rotation angle could be progressive until canceled by 
G69 or power off to reset the angle to zero. 
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Figure 4-54  Rotation

The relation between G68 and G17/G18/G19 is as below:

Figure 4-55  The relation between G68 and G17/G18/G19

4.5.2   G50/G51：Scaling or Mirror off∕on

Format：

G50;
G51 X_Y_Z_I_J_K_ ; or G51 X_Y_Z_P_;

G51 enables system to scale up / down and mirror. The center of scaling or mirror is defined 
by X_, Y_ and Z_ in the instruction. If X_, Y_ and Z_ are all missing from the command line, 
the current position will be used as the center.
The magnification is defined by I_, J_ and K_ for each axis separately or by P_ for all axes. 
If one or more but not all of I_, J_ and K_ is defined, the missing component will be defined 
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by the default parameter. 
If I_, J_ , K_ and P_ are all missing, the default P_ parameter will be used.
As for scaling, I_, J_ , K_ or P_ has to be greater than zero. For mirror, I_, J_ or K_ will 
be negative, which corresponds to mirror image with respect to axis X_, Y_, or Z_.

Note:

1. The 4th axis will be no effected by G51. Mirror and scaling function are only effective on 
X,Y and Z axes. 

2. The center point〔X_Y_Z_〕of scaling can be absolute or incremental dimension 
〔specified by G90/G91〕.

3. When the scaling factor of any two among axes are different, the radius of the arc will  be 
specifed by the larger scale and the center position of the arc will renew to calculate by 
the larger scale.

4. If G50/G51 and G68/G69 exist simultaneously in the program, the edit sequence is that 
G51 first and then G68 when enable, but G69 first and then G50 when cancel. This way 
must be observed, or the system will pop up a alarm dialog box.

The part contour is in proportional to the same scaling factor of three axes, and it is illustrated 
as below:

Figure4-56   The part contour is in propotional to the same scaling factor of three axes
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The part contour isn't in propotional to the scaling factor of two axes, and it is illustrated as 
below:〔Note: The arc center is be shifted, and the radius is enlarged in propotional to the 
larger scaling factor.〕

Figure 4-57  The part contour isn't in propotional to the scaling factor of two axes

The part contour is in propotional to the same scaling factor of two axes, do mirror image of Y 
axis,and it is illustrated as below:

Figure4-58   The part contour is in propotional to the same scaling factor of two axes, do mirror image of Y axis
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4.6  Spindle Rotation Instructions

4.6.1  List of M Codes

M codes can be distinguished into two group:

1. Group 1: For Program Execution Control

M code Format Function description
M00 M00; program hold
M01 M01; Optional hold
M02 M02; end of program and stay at the end of program
M30 M30; end of program and rewind to the start of 

program
M95 M95 P_P_L; internal program nested execution〔from 1st P_ 

to 2nd P_, L_ times〕
M96 M96 H_ P_ conditional jump〔 to P_ if H_ is TRUE〕
M97 M97 P_L_; internal subroutine call
M98 M98 (filename)L_; external subprogram call L_ times
M99 M99; return from subroutine∕subprogram∕endless 

loop
M100 M100 Program hold for manual feed operation
M101 M101 Optional hold for manual feed operation

Note: M-code for Program Execution Control must exist alone in a block. No other codes 
exist simultaneously in the same block.
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2. Group 2: Spindle / Tool / Miscellaneous Control

M code Format Function description
M03 M03 S_; spindle on cw with speed S rpm
M04 M04 S_; spindle on CCW with speed S rpm

* M05 M05; Spindle off
M06 M06 T_; Tool change
M08 M08; Turn on cooling∕clean device

* M09 M09; Turn off cooling∕clean device
# M29 M29; Rigid Tapping

Note：

1. * ：〔Specified by PLC〕Initial M-code in the group when turning power on.
2. Whether M06/M08/M09 exist or not, it depends on machine tool and these functions are 

programmed by PLC. 
3. Only one Miscellaneous Control M-code can exist in a block. However, it can exist with 

G-codes simultaneously in the same block.
4. #： The M code of rigid tapping can be changed in machine parameter. M29 is the default 

M code of rigid tapping and being used mostly.

4.6.2  M03/M04/M05：Turn On or Off Spindle

Format：

M03 S_; turn on spindle CW
M04 S_; turn on spindle CCW
M05; turn off spindle

When M03/M04/M05 exists with Motion G-code in the same block, the PLC programmer 
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usually programs  M03/M04〔spindle CW∕CCW rotation turning on〕 before the block 
program execution but M05〔 spindle stop〕 after finishing the block program execution.

It had better program M03/M04/M05 in a block alone, and don’t combine with other motion 
command. So that it can guarantee the spindle speed being in steady condition when perform 
the cutting and the spindle stop after finished the cutting. 

4.6.3  S code：Spindle Speed Setting

Format：

Sxxxxxx;   Change the spindle speed by S_ code in rpm

S_ shows usually by 4 digits to denote the value of rpm of spindle, and it shows up to 6 
digits. S_ just sets how fast spindle rotates but doesn't enable spindle to rotate. As soon as the 
M03 or M04 exists the spindle rotates.

4.6.4  G96/G97：Constant Surface Speed 
Control on / off

Format：

G96 S_;
G97 S_;

G96: turns on constant surface speed control

The spindle speed will be calculated so that the surface speed will be unchanged no matter 
how tool position changes.
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G96 enables the constant surface speed control, and a cylindrical work piece which is 
clamped on the spindle, is under control too, and the tangent speed of tool nose relative to the 
surface of the cylindrical work piece will be controlled in S_ value. This S_ value can be up 
to five digits and in the unit of m∕min or inch∕min.

On performing the constant surface speed control, it is usually assume the Z axis as the 
rotation axis of the work piece, and the X axis being the radius axis. The X axis zero point of 
program position has to be at the center of work piece to get surface feed speed. The rotation 
speed of the spindle will be increase if the radius〔X value〕decreases.

G97: turns off constant surface speed control

The spindle speed is a constant. G97 cancel the constant surface speed control, and specified 
the S_ value restore to revolutions per minute.

Figure 4-59  Constant Surface Speed Control       Figure 4-60  The relative figure about spindle speed and X value

4.6.5  G94/G95：Feed per Minute / Revolution

Format：

G94 F_;
G95 F_;

G94: specifies feed per minute, the F_ value commanded represents feed per minute.
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G95: specifies feed per revolution, the F_ value commanded represents feed per spindle 
revolution.

Figure 4-61  feed per revolution

Note:

The digit definition of F_ value in G94 and G95 are different:

1. In G94 mode, the integer value of  F_ data will be the same as that of specify a decimal 
point in behind .F300 will be the same as F300. or F300.0. And the dot in F300.05 
or F300.6 will still effective.

2. In G95 mode, the integer value of  F_ data will be converted to be in the least unit of that 
system. Therefore F300 will be converted to F0.300 in G99 mode. And the dot in 
F300.05 or F300.6 will still effective.

The ranges of  F_ data in metric∕inch system:

Mode G21〔Metric system〕 G20〔Inch system〕

G94 F0.001～F60000
〔0.001～60000 mm∕min〕

F0.0001～F2362
〔0.0001～2362 inch∕min〕

G95 F0.001～F999.999
〔0.001～999.999 mm∕rev〕

F0.0001～F39.3700
〔0.0001～39.3700 mm∕rev〕
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4.7  Unit & Coordinates 
Instructions

4.7.1  G17/G18/G19：Plane Selection

Format：

G17;XY plane selection
G18;ZX plane selection
G19;YZ plane selection

Some G codes only work on the specified plane. For example, chamfering/corner rounding of 
G01, G02/G03 circular interpolation, G16, G41/G42, G68 and so on. We must give plane 
selection G code〔G17/G18/G19〕in front of these G codes. The forth axis does not work 
at these G codes. The initial code is G17 in this G code class.

Figure 4-62  G17, G18 and G19 plane selection
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4.7.2   G20/G21：Input in Inch / Metric

The value of each address in the programming block can be programmed in Metric or Inch. 
The default unit when power on depends on the last turning off setting. G20 or G21 must be 
programmed in the first block of the CNC program. As soon as the instruction  G20 or G21 is 
specified the mode can't change anymore. We can also switch G20 or G21 by 
〝Parameter→Attribute〞or 〝Run→MDI〞. 

The acceptable range in Metric / Inch mode:

Inch mode〔G20〕: 0.0001~999.9999 inch
Metric mode〔G21〕:0.001~9999.999 mm

4.7.3   G90/G91：Absolute / Incremental 
Dimension

Format：

G90;Programming in absolute dimension
G91;Programming in incremental dimension

Must input end position X_,Y_ and Z_ which can be programmed in absolute or incremental 
dimension in Motion G Codes. This is specified by G90 or G91. 

When move the tool from  A(150,300,120) to B(100,240,90) ,〝 G90 X100 
Y240 Z90; 〞denotes program in absolute dimension〔G90〕 illustrated as the following 
figure. 
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Figure 4-63   G90; Programming in absolute dimension      

〝 G90 X-50 Y-60 Z-30; 〞denotes program in incremental dimension〔G91〕 

illustrated as the following figure. 

Figure 4-64   G91;  Programming in incremental dimension

4.7.4   G15/G16：Cartesian / Polar Coordinate 
System

Format：

G15; Programming in Cartesian coordinate
G16; Programming in polar coordinate

Must input end position X_, Y_ and Z_ which can be programmed in Cartesian or polar 
coordinate in Motion G Codes. This is specified by G15 or G16. G15 is the default code of 
this class. When program in polar coordinate, must specify G16 previously.
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Figure 4-65  G15: Programming in Cartesian 
coordinate 

Figure 4-66  G16: Programming in polar coordinate

Note: polar coordinate is closely related to plane selection. The plane selection 〔G17/G18/
G19〕has the priority to set up.

Polar coordinate use X_, Y_ and Z_ to denote its address code. The meanings of X_, Y_ and 
Z_ are listed below：

X Y Z
G17 radius angle height
G18 angle height radius
G19 height radius angle

The definition of positive angle is the angle of rotating counter clockwise from the 1st axis on 
the specified plane, and list as below: 

G17: rotate from X axis to Y axis.
G18: rotate from Z axis to X axis.
G19: rotate from Y axis to Z axis.
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Figure 4-67  The definition of positive angle in polar coordinate

G90 and G91 are still effective in polar coordinate,such as radius and angle in absolute or 
increment dimension. When initially switching coordinate to the polar coordinate, the 
definitions of radius and angle in G90/G91 mode are varied conditions as follows:

Figure 4-68   When initially switching coordinate to the polar coordinate, the definitions of radius and angle in 
G90/G91 mode are varied conditions
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Note: When the angle is programmed in incremental dimension, the initial angle is defined as 
the absolute angle of current position P1. Then, add the incremental angles to the initial angle. 
If the current point is located at the zero point〔origin〕, then the initial angle is zero.

The radius and angle of polar coordinate are specified in absolute or incremental dimension 
by G90/G91.The end position are different because of the sequence of radius and angle 
setting by G90 or G91. The possible conditions are illustrated as below:

1. When the radius is specified in absolute dimension first
   

Figure 4-69  When the radius is specified in absolute dimension first  

2.  When the radius is specified in incremental dimension first

Figure 4-70  When the radius is specified in incremental dimension first

The varied conditions according to the sequence of radius or angle in absolute or incremental 
dimension are illustrated as below:
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Figure 4-71  The varied conditions according to the sequence of radius or angle in absolute or incremental 
dimension

Note: If the current position P1 were located at zero point origin, r1=a1=0.
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4.7.5   G54～G59：Work Coordinate System 1~6 
Selection

Format：

G54
G55
G56
G57
G58
G59

Up to 6 work coordinate systems can be selected by G54 to G59. The offsets of these 6 work 
coordinate systems are set in the parameter which will add on to the offset created by  G92  to 
form the total offset.

The default work coordinate system when power turns on is the coordinate system defined by 
G54.

Figure 4-72   Work Coordinate System 1~6 Selection
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4.7.6   G52：Set Local〔Child〕Coordinate 
Offset

Format：

G52 X_ Y_ Z_ A_;

G52 sets the offset of a local〔child〕coordinate system relative to the origin of the work 
coordinate system.

The offset will be commanded by X_Z_. Cancel the local coordinate by G52 X0 Z0.

Figure 4-73   G52: Set Local〔Child〕Coordinate Offset

4.7.7   G92：Set Program Position/ G92 
External Offset

Format：
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G92 X_ Y_ Z_ A_;  Set Program Position
G92; G92 External Offset

G92 sets the program position of the current machine position as the position commanded by 
X_,Y_,Z_. Therefore , sets an external offset of the program position from the current 
machine position, which then sets the origin of work coordinate system.

Note: When tool radius or length compensation is on, G92 can not be applied.

Figure 4-74   G92：Set Program Position/ G92 External Offset
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4.8  Program Executing 
Instructions

4.8.1   G04：Dwell Time

Format：

G04 X(U)_;
G04 P_;

G04 is specified to pause program in X_, U_ or P_ seconds.

The G04 instruction can be applied to the following conditions:

1. When spindle shifts gear, execute G04 to pause some seconds upon finishing M05. Make 
sure spindle stop and then shift gear to protect servo of spindle from damage. 

2. When cutting on the bottom of hole, execute G04 to pause some seconds. That can 
improve the precision of the depth and the surface on the bottom, such as beam hole, 
taper hole, spot facing and so on.

3. When tapping thread with  large radius, execute G04 to pause some seconds. Make sure 
spindle speed steady and then tap thread can make the screw pitch correct. 

Dwell time is from 0.001 second to 9999.999 second in metric system. Dwell time is from 
0.0001 second to 999.9999 second in imperial system.

If no X or P is commanded, G04 will act exact like the instruction G09 for exact stop mode.
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4.8.2  G09：One Shot Exact Stop

This is a one shot command, it only effects in the line of G09 commanded.

The G09 commands tool to be located at the specified position and execute in-position check. 
G09 is just effective when it is programmed with the Motion G Codes. G09 makes the 
Motion G code of specified axis confirm its end position and cut desired acute angle. 

Both G09 and G61 can execute Exact Stop〔In Position Check〕. The difference between 
G09 and G61 is that G09 is One Shot Command but G61 is sustained command.

4.8.3  G60/G61：Cancel / G61 Exact Stop Mode

Format：

G60;Cancel G61 Exact Stop Mode〔In Position Check Off〕
G61;Exact Stop Mode On〔In Position Check On〕

G61 turns on the exact stop mode and the following cutting commands, such as  G01, G02, 
G03, G33 and so on, will perform in-position check until G60 cancel it.

The CNC programs designed by CAD will cut many line segments. If G60 canceled the exact 
stop mode, these line segments get a smooth contour by cutting continuously.  

Note: Some instructions related to positioning, such as G00, G53, G28 and G29, have 
executed Exact Stop Mode automatically upon reaching end position. Therefore G61/G60 is 
not effective to these G codes.
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4.8.4   M00/M01/M100/M101/M02/M30： Program 
Hold∕Stop

Format：

M00; Program Hold
M01; Optional hold
M100; Program hold for manual feed operation
M101; Optional hold for manual feed operation
M02; End of Program
M30; End of Program Rewind

M00：Program Hold

Program pause immediately. Press F9 to resume program execution.

M01：Optional hold

The function of  M01 is the same as one of M00. M01 is just effective when it highlights in the 
system state window. When M01 doesn't  highlight, M01 will be skip.〔 In other words, the 
program will not stop because of  M01.〕

M100/M101：Program hold / Optional hold for manual feed 
operation 

M100/M101 is similar to M00/M01, But M100/M101 enables feed toward or backward 
operation after program hold. That can check correction of cutting path. Press Cycle Start 
button or F9 to restore program execution.
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M02：End of Program

M02 is terminate program execution, and stay at the end of the program. M02 makes spindle 
stop 〔M05〕, cutting oil turn off〔M09〕,and the cursor stay at the M02 block instead of the 
first block in a program. Pogrom doesn't execute anymore even press Cycle Start button or 
F9. Must reload the program to restore execution.

M30：End of Program Rewind

M03 is terminate program execution, and rewind to the start of the program. M30 makes 
spindle stop 〔M05〕, cutting oil turn off〔M09〕,and the cursor return automatically to the 
first block in a program. That is convenient to execute program again. 

Note: Press Cycle Start button of F9 depends on machine parameter. Please ask your machine 
maker for service.

4.8.5   M95/M97/M98/M99：Inner program / 
subroutine / subprogram call or return

Format：

M95 P_P_L; Internal Program Nested Execution〔from 1st P_ to 2nd P_, L_ times〕
M97 P_L_; Subroutine Call L_ times
M98 (filename)L_; Subprogram Call  L_ times
M99; Return from Subroutine∕Subprogram

Note: 

1. If using M99 instead of M02/M30 at the end of program, then the program will be 
repeated execution.

2. All these subprogram or subroutine call can be used in nesting. The maximum nest layer 
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number of these program or subroutine call can be up to eight layers.

Figure 4-75   The maximum nest layer number of these program or subroutine call can be up to eight layers.

4.8.5.1   M95：Internal Program Nested Execution

Format：

M95 P_P_L; 

M95 executes a nested program run inside the current program from a commanded start line 
to a commanded end line which both have to be in front of  M95 command.
In command line, start and end line will each be defined with a P_ code. Also, an L_ code 
defines the repetition count.

In program, the specified start and end line will be defined with N_ codes.

SAMPLE95.CNC Description
;SAMPLE OF M95 CALL
N10 M_;
N20 G_Y_; Start of nest 1〔N20〕

N30 X_; Start of nest 2〔N30〕

N40 G_X_;
N50 Y_;
N60 Z_;  End of nest 2〔N60〕
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N70 X_;
N80 M95 P30 P60 L5; Execute from N30 to N60 five times
N90 G_X_Y_; End of nest 1〔N90〕

M95 P20; Execute from N20 to N90 one times
M02; Program end

4.8.5.2   M97：Internal Subroutine Call  L_ times

Format：

M97 P_ L_

M97 calls a subroutine L_ times. The subroutine and the main program must be in the same 
file, and the subroutine follows the main program.

The subroutine is named〝Oxxxx〞. 〝xxxx〞denotes the value of P_ in M97 block by 
four digits. The subroutine must end with M99〔subroutine return〕

Example1:

SAMPLE97.CNC Description
;SAMPLE OF M97 CALL Main program
G50 X0 Y0 Z0;
M03;
M97 P1005 L3; Call subroutine O1005 three times
M97 P2001; Call subroutine O2001
M05;
...
M02; End of main program
O1005 Start of subroutine O1005
...
M99; End of subroutine  O1005 
;
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O2001; Start of subroutine O2001 
...
M99; End of subroutine O2001 

Example 2:

SAMPLE97.CNC Description
;SAMPLE OF M97 CALL Main program
G50 X0 Y0 Z0;
...
M97 P1005 L3; Call subroutine O1005 three times
...
M30; End of main program
;
O1005 Start of subroutine O1005
...
M97 P2001; Call subroutine O2001
...
M99; End of subroutine O1005 
;
O2001; Start of subroutine O2001
...
M99; End of subroutine O2001

4.8.5.3   M98： External Subprogram Call L_ times

Format：

M98 (FILENAME) L_

M98 calls an external subprogram which has existed in the file list. The subprogram must end 
with M99〔subprogram return〕. A repetition count can also be commanded with an L_ 
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code.

Note: the format of  M98 is 〝M98 Program name L___〞, and doesn’t need any 
leading alphabet before the program name, but it must need a space between the program 
name and the L_ character.

Example:

 SAMPLE98.CNC Description

;SAMPLE OF M98 CALL
G92 X0 Y0 Z0;
G91 G00 X100 Y100;
M03;
M98 SUB1OF98 L3; Call external subprogram SUN1OF98 three 

times
M98 SUB2OF98; Call external subprogram SUN2OF98 
M05;
...
M02;
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 SUB1OF98.CNC Description

;SUB_PROGRAM 1
G01 Z-10;
X50 Y50;
G02 X50 Y-50 R50;
G01 X-100;
G00 Y-200;
M99; End of external subprogram SUB1OF98.CNC, and return to 

SAMPLE98.CNC

SUB2OF98.CNC Description
;SUB_PROGRAM 2
...
M98 SUB3OF98; Call external subprogram SUB3OF98
...
M99; End of external subprogram SUB1OF98.CNC，and return 

to SAMPLE98.CNC

SUB3OF98.CNC Description
;SUB_PROGRAM 3
...
...
M99; End of external subprogram SUB1OF98.CNC, and return to 

SAMPLE98.CNC

4.8.5.4   M99： Subprogram Return

M99 returns the program execution to the calling program. All subroutines∕subprograms 
must have M99 as its very last code. However, if  M99 is not within a subroutine or 
subprogram, the program will do endless loop.
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4.9  Reference Position 
Instructions
Reference point can be used as the position of tool changing, or the temporary staying 
position for work piece changing. Up to four reference points can be used, and the offset 
value of each reference point relative to the zero point of machine coordinate can be set in the 
〝Parameter→Reference positions…〞. 

The machine zero point is the index position of all reference points, therefore the 〝Home〞 

operation must be done before using the reference position command. The machine parameter 
can set whether Homing first and then using machine. It usually selects the item〝Homing 
first〞.

Note: When machine has special needs and not to select the item〝Homing first〞, the tool 
position upon turning on is regarded as the origin of machine position and the reference 
positions change their positions with it. Under this situation, executing Reference Position is 
very possible to crash work piece to damage work piece or tool.

4.9.1   G28：Return to Primary Reference 
Position through Intermediate Point

Format：

G28 X_ Y_ Z_ A_;

X_ Y_ Z_ A_ is the position of  intermediate point.

G28 commands tool to return to primary reference position with G00 speed. G28 can indicate 
a safety path, move tool to return to primary reference position along this safety path , and 
then execute the instruction about changing tool. The intermediate (X,Y,Z,A) point can be 
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programmed in absolute or incremental dimension. If  just gave G28 without specified axis, 
G28 would not be effective.

The primary reference position is set by〝Parameter→Reference positions〞. Input value is 
the vector from machine origin to reference position.

Figure 4-76   G28：Return to Primary Reference Position through Intermediate Point

4.9.2  G29：Move to End Point from Primary 
reference position through Intermediate Point

Format：

G29 X_ Y_ Z_ A_;

X_ Y_ Z_ A_ denotes the position which tool reaches to in the end.

G29 commands tool to reach end point from primary reference position through the 
intermediate point specified by G28. G29 can indicate a safety path, move tool to end 
position along this safety path. Must give G28 instruction before G29, or G29 doesn't know 
where the intermediate point is and system alarms. 
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Figure 4-77  G29：Move to End Point from Primary reference position through Intermediate Point

4.9.3  G30：Return to the 2nd, 3rd  or 4th 

Position through Intermediate Point

Format：

G30 X_ Y_ Z_ A_ P_; 

P_ means the 2nd, 3rd or 4th reference point selected. X_ Y_ Z_ A_ means intermediate 
position. 

G30 commands tool return to selected reference point through the intermediate point. G30 is 
similar to G28. The difference between G30 and G28 is G28 returns to primary reference 
point, but G30 returns to the 2nd, 3rd or 4th reference point selected.

The  2nd, 3rd or 4th reference position is set by〝Parameter→Reference positions〞. Input 
value is the vector from machine origin to each reference position.
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Figure 4-78  G30：Return to the 2nd, 3rd  or 4th Position through Intermediate Point

Note：

1. Under G28 or G30 mode, after tool moves to primary, 2nd, 3rd or 4th reference point, the 
work coordinate system is changed to another one, and then the intermediate point is also 
changed with new coordinate system. When G29 follows G28 or G30 later, the tool will 
reach to end position through the intermediate point of new work coordinate system.

2. Cancel the length or radius compensation instructions 〔G49、G40〕before G28 or 
G30.

4.10  Miscellaneous Instruction

4.10.1   M08/M09：cooling or clean device turn 
on / off

Format：

M08 ; cooling / clean device turn on
M09 ; cooling / clean device turn off
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Note： M codes function are defined by PLC.

4.10.2    T# : Tool Selection

Format：

Txx;
Txxxx;

T code is also named tool function which consists of  address T and 2 digits following T.

How to change tool depends on tool changer machine. Some of tool changers are disk model 
and some are chain model. There are two methods of tool changers, no robot arm and with 
robot arm. The tool changer without robot arm is move tool storehouse to approach spindle 
first, unload the original tool on spindle, switch the other tool desired, and then load it. Most 
of the tool storehouse are disk model and fixed tool number〔It denotes No.1 tool must return 
to No.1 tool storehouse〕. The tool change in program edits as below: 

M06 T03;
M06 is a tool change instruction which unload the original tool in spindle, switch it to No. 3 
tool, and load No.3 tool in spindle. 
 

Most of the tool changer with robot arm combine with chain tool storehouse and have no 
fixed tool number〔these words denote No.1 tool may not return to No.1 tool storehouse and 
tool number setting is set by PLC〕. The tool changer of this model means call tool by the 
digits following T.  When T code enables, the called tool will switch itself to tool change 
position but no motion of tool change actually. Therefore T code must be specified before 
M06 to save the waiting time of tool change.
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4.10.3   M06：Tool Setting

Format：

M06;

M06 commands ATC〔automatic tool changer〕to change tool.

It is not all available to change tool anywhere. Tool change depends on the design of machine 
maker. Most tool changes at a safety location where to avoid crashing of machine and work 
piece. The machine origin of Z axis is usually the safety position furthest work piece. 
Therefore execute M06 normally after tool returns to machine origin of Z axis.  

Note: Make sure ATC has been installed before executing M06. Please ask your machine 
maker for detail. 

4.10.4   G10/G11：Data Setting Mode On ∕ Off

Format：

G10 (P_R_L_);
G11;

User can use G10 to switch on the data setting mode of length and radius compensation in 
CNC program. This command is modal, i.e., G10 will be effective until canceled by G11.
G11 is NECESSARY to cancel the data setting mode, else alarm will be issued when other 
codes are commanded.

In data setting command line, the only commands allowed are G10/G11 and G90/G91. The 
data is absolute or incremental depends on the current state of G90/G91.

For G10, the command arguments are:
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P_ : tool entry
R_ : tool radius
L_ : tool length

G10 can stand alone in the command line to just switch on the data setting mode for the data 
setting command lines follows, or, it can has complete arguments with it. However, if 
arguments follows, P_ must exist to specify the data entry.

Example:

G90 G10 P1 R1. L10.  ; Tool 1, Radius=1., Length=10.
G10 P2 R2. L20.      ; Tool 2, Radius=2., Length=20.
G10 P3 R3. L30.      ; Tool 3, Radius=3., Length=30.
G10 P4 R4. L40.      ; Tool 4, Radius=4., Length=40.
G91 G10 P5 R-0.5     ; Tool 5, Radius=-0.5.
G90 G11              ; Data setting mode off

or

G90 G10              ; Data setting mode on
P1 R1. L10.          ; Tool 1, Radius=1., Length=10.
P2 R2. L20.          ; Tool 2, Radius=2., Length=20.
P3 R3. L30.          ; Tool 3, Radius=3., Length=30.
P4 R4. L40.          ; Tool 4, Radius=4., Length=40.
G91                  ; To incremental mode
P5 R-0.5             ; Tool 5, Radius=-0.5.
G90 G11              ; Data setting mode off
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4.11  Examples of  programs of M 
series
The examples of G codes combination list as below: there are more example in 
〝Help→Code index〞.

4.11.1   The example : G54~G59 Work 
Coordinate

SAMPL54.CNC：
; Set 〝Parameter→Coordinate offsets〞
; G54 X0 Y0 Z0
; G55 X200. Y200. Z0
; G56 X400. Y100. Z0 previously.
;
G92 X0 Y0 Z0;
G90;
/M03;          Spindle turn on
G54 G00 Z0;    Select work1
M98 SUBWORK1;  Call sub.
G55;           Select work2
M98 SUBWORK1;  Call sub.
G56;           Select work3
M98 SUBWORK1;    Call sub.
/M05;                       Spindle turn off
G54 G00 X0 Y0 Z0;
M30;
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SUBWORK1.CNC：
;subroutine of cutting a work
G90;
G00 X0 Y0;
/G01 Z-5. F500.;
G01 X100. F1500.;
X90. Y10.;
G03 X10. Y90. I-40. J40.;
G01 X0 Y100.;
Y0;
/Z0;
M99

Figure 4-79  An example is illustrated
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4.11.2   The example : G52 Child Coordinate

SAMPL52.CNC：
; Set 〝Parameter→Coordinate offsets〞
; as SAMPL54 noticed
; and then run this program
; notice the difference of tool path from SAMPL54
; 
G92 X0 Y0 Z0;
G90;
/M03;           Spindle turn on
G52 X100. Y50.; Set child coordinate.
G54 G00 Z0;            Select work1
M98 SUBWORK1;   Call sub.
G55; Select work 2
M98 SUBWORK1;   Call sub.
G56; Select work 3
M98 SUBWORK1;   Call sub.
/M05;           Spindle turn off
G54 G00 X0 Y0 Z0;
M30;

SUBWORK1.CNC：
;Subroutine of cutting a work
G90;
G00 X0 Y0;
/G01 Z-5. F500.;
G01 X100. F1500.;
X90. Y10.;
G03 X10. Y90. I-40. J40.;
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G01 X0 Y100.;
Y0;
/Z0;
M99

Figure 4-80  An example is illustrated
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4.11.3   The example : G43 Tool Length 
Compensation

SAMPL43.CNC：

; Set〝Parameter→Tool table〞:
;T1 length to 10 mm previously.
;Then run the program
G90;
/M03;         Spindle turn on
G00 Z0; 
M98 SUBWORK1;  Call sub1.
G43 H1;       Tool length compensation on
M98 SUBWORK1; Call sub1.
G49 G00 Z10;
/M05;         Spindle turn off
M30;          Program end
;
;Change T1 length to -15 mm, and then run the program again. 
;Notice the change of the path of tool tip.

SUBWORK1.CNC：
; Subroutine of cutting a work
G90;
G00 X0 Y0;
G01 Z-5. F500.;
X100. F1500.;
X90. Y10.;
G03 X10. Y90. I-40. J40.;
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G01 X0 Y100.;
Y0;
Z0;
M99

Figure 4-81  An example is illustrated
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4.11.4   The example : G41/G42 Tool Radius 
Compensation

SAMPL41.CNC：
; Set〝Parameter→Tool table〞:
; T1 radius to 2.5 mm previously
; Start of normal path
; 
G17 G90
G92 X0 Y0 Z0
G0 X100. Y100.
M97 P1041;      Call sub O1041
G0 X0 Y0
M01;            End of normal path
;
;Start of cutter left compensation
H1;             Select tool No.1
G41 G0 X100. Y100. 
M97 P1041;              Call sub O1041
G40 G0 X0 Y0;   End of G41
M30;            Program end
;
O1041;          Subroutine
G01 X200. F1500.
X190. Y110.
G03 X110.Y190.I-40.J40.
G01 X100. Y200.
Y100.
M99;            End of subroutine 
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Figure 4-82  An example is illustrated

SAMPL42.CNC：
; Set〝Parameter→Tool table〞:
; T1 radius to 2.5 mm previously
; Start of normal path
G17 G90
G92 X0 Y0 Z0
G0 X100. Y100.
M97 P1042;         Call sub O1042
G0 X0 Y0
M01;               End of normal path
;
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;Start of cutter right compensation
H1;                Select tool No.1
G42 G0 X100. Y100. 
M97 P1042;                      Call sub O1042
G40 G0 X0 Y0;               End of  G42
M30;                                     Program end
;
O1042;                                Subroutine
G01 X200. F1500.
X190. Y110.
G03 X110.Y190.I-40.J40.
G01 X100. Y200.
Y100.
M99;                                     End of subroutine

Figure 4-83  An example is illustrated
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4.11.5   The example : G16 Polar Coordinate 

SAMPL16A.CNC
; Hexagon
;  Absolute radius, Absolute angle
G92 X0 Y0 Z0
G16; Switch to polar coordinate.
G90 G0 X200. Y60.;r=200. angle=60.
G1 Y120. F1500.; absolute angle
Y180.
Y240.
Y300.
Y360.
Y60.
G15; polar coordinate off
G90 G00 X0 Y0 
M30

Figure 4-84  An example is illustrated
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SAMPL16B.CNC
; Octagon
;  Absolute radius, Incremental angle
G92 X0 Y0 Z0
G16; Switch to polar coordinate.
G90 G0 X200.Y45.; r=200. angle=45.
G91 G1 Y45.F1500.; Incremental angle
N10 Y45.        
M95 P10 L6
G15; Polar coordinate off
G90 G00 X0 Y0    
M30

Figure 4-85  An example is illustrated
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SAMPL16C.CNC：
; Hexagon
; Incremental radius, Incremental angle
G92 X0 Y0 Z0
G16; Switch to polar coordinate.
G91 G0 X200. Y60.
G1 X200. Y120. F1500. ;
N10 Y60.        
M95 P10 L4
G15
G90 G00 X0 Y0    
M30

Figure 4-86  An example is illustrated
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SAMPL16D.CNC：
; Lotus flower
; Incremental radius, incremental angle
G92 X0 Y0 Z0
G91
G16 G0 X100. Y0. F1500.
N10 G2 X250. Y160. R200.
M95 P10 L8
G15 
G90 G0 X0 Y0 Z0
M30

Figure 4-87  An example is illustrated
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SAMPL16E.CNC
; Star fish
;  Absolute radius, Incremental angle
G92 X0 Y0 Z0
G90 G16 G0 X200. Y0
G91 G2 Y144. R200. F1500.
N10 Y144. R200.
M95 P10 L4
;
N20 Y72. R200.
M95 P20 L4
G15
G90 G0 X0 Y0
M30
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Figure 4-88  An example is illustrated

SAMPL16F.CNC

; Magic crystal
; Absolute radius, incremental angle
G92 X0 Y0 Z0
G90 G16 G0 X100. Y45.
G91 G1 X200. Y162. F1500.
N10 Y162.
M95 P10 L18
G15
M30
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Figure 4-89  An example is illustrated

4.11.6   Miscellaneous Examples：

G01 corner chamfer and round : TS-G1-LR.CNC

; G1 with corner chamfer and round and their mirror paths
G92 X0 Y0 Z0
G91
G17; on X-Y plane
M97 P1217; Original path
G51 X Y Z I-1000 J1000 K1000
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M97 P1217; Mirror to X axis
G50
G51 X Y Z I1000 J-1000 K1000
M97 P1217;Mirror to Y axis
G50
G51 X Y Z I-1000 J-1000 K1000
M97 P1217; Mirror to diagonal of X and Y axis
G50;
G90 G0 X0 Y0 Z0
M30
;
O1217
G0 X8. Y8. Z8.
G1 X20. F500.
Y10. L3.;chamfering corner
X-20. R5.;rounding corner
Y-10.
G0 X-8. Y-8. Z-8.
M99
;
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Figure 4-90  An example is illustrated

G16 mirror sample program:TS16-PLN1.CNC
G16 program the polar system on each plane
G92 X0 Y0 Z0
G91
G0 X-40.
G92 X0 Y0 Z0
G17 G16; Polar system on XY plane
N1 G1 X10. Y30. F1000.
Z10.
X10. Y180.
Z-10.
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X0 Y180.
M95 P1L11 ; Loop from N1 11 times
G15;
G0 X40.
G92 X0 Y0 Z0
G18 G16   ; Polar system on XZ plane
N2 G1 Z10. X30. F1000.
Y10.
Z10. X180.
Y-10.
Z0 X180.
M95 P2L11 ;Loop from N2 11 times
G15;
G0 X40.
G92 X0 Y0 Z0
G19 G16   ;Polar system on YZ plane
N3 G1Y10. Z30. F1000.
X10.
Y10. Z180.
X-10.
Y0 Z180.
M95 P3L11 ;Loop from N3 11 times
G15;
G0 X-40.
G92 X0 Y0 Z0
M30.
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Figure 4-91  An example is illustrated

4.11.7   The example : G51/G68 Mirror, scaling 
and rotation

G51 mirror sample program：SAMPL51A.CNC
; Mirror function on each plane
G92 X0 Y0 Z0
G91
;

221



 INCON-ME3 CNC Controller Guide of Milling

G17 G0 X-35. ; on X-Y plane
G92 X0 Y0 Z0
M97 P1234   ; Original path
G51 X Y Z I-1000 J1000 K1000
M97 P1234   ; Mirror to X axis
G50
G51 X Y Z I1000 J-1000 K1000
M97 P1234   ; Mirror to Y axis
G50
G51 X Y Z I-1000 J-1000 K1000
M97 P1234   ; Mirror to diagonal of X and Y axis
G50
;
G18 G0 X35.  ;on Z-X plane
G92 X0 Y0 Z0
M97 P1234   ; Original path
G51 X Y Z I-1000 J1000 K1000
M97 P1234   ; Mirror to X axis
G50
G51 X Y Z I1000 J1000 K-1000
M97 P1234   ; Mirror to Z axis
G50
G51 X Y Z I-1000 J1000 K-1000
M97 P1234   ; Mirror to diagonal of X and Z axis 
G50
;
G19 G0 X30.  ; on Y-Z plane
G92 X0 Y0 Z0
M97 P1234   ; Original path
G51 X Y Z I1000 J1000 K-1000
M97 P1234   ; Mirror to Z axis
G50
G51 X Y Z I1000 J-1000 K1000
M97 P1234   ; Mirror to Y axis
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G50
G51 X Y Z I1000 J-1000 K-1000
M97 P1234   ; Mirror to diagonal of Y and Z axis
G50
G0 X-30.
G17 G92 X0 Y0 Z0
M30
;
O1234
G0 X5. Y5. Z5.
G1 X10. F500.
Y10.
X-10.
Y-10.
X10. Y10.
X-10. Y-10. Z12.
Z-12.
G0 X-5. Y-5. Z-5.
M99
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Figure 4-92  An example is illustrated

G68 rotation and G51 mirror sample: TS68-51A.CNC
; the combination of rotation and mirror on XY plane
G17 G91
G92 X0 Y0 Z0
M97 P0123   ; original path in first quadrant 
G51 X Y Z I-1000 J1000 K1000
M97 P0123   ; Mirror to X axis
G50
G51 X Y Z I1000 J-1000 K1000
M97 P0123   ; Mirror to Y axis
G50
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G51 X Y Z I-1000 J-1000 K1000
M97 P0123   ;  Mirror to diagonal of X and Z axis in third quadrant 
G50 
M30
;
; 
O0123       ;case 1
M97 P1234   ;original path
G68 X0 Y0 R90.; rotate 90° and duplicate a path
M97 P1234   
G69
M99
;
; 
O1234        ;case 2
G0 X10. Y5.
G1 X10. Y10. F1500.
X10.
X10. Y-10.
X-10.
X-5. Y5.
X-5. Y-5.
X-10.
G0 X-10. Y-5.
M99
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Figure 4-93  An example is illustrated

If we change the content in subprogram O0123 as follows,   then we’ll get other tracing 
paths:

; 
;〔case 1〕rotate and duplicate
O0123  
G68 X0 Y0 R45. ; rotate 45°
M97 P1234   ;duplicate a path
G69        
G68 X0 Y0 R-45.; rotate -45°
M97 P1234   ;duplicate a path
G69        
M99
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Figure 4-94  An example is illustrated

 ;〔case 2〕original path
 O0124 
 M97 P1234    ; original path
 G68 X0 Y0 R45.; rotate 45°
 M97 P1234    ; duplicate a path
 G69          
G68 X0 Y0 R90.; rotate 90°
M97 P1234    ; duplicate a path
G69          
G68 X0 Y0 R135.; rotate 135°
M97 P1234   ; duplicate a path
G69         
M99
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Figure 4-95  An example is illustrated

4.11.8   The Example : G73~G89 cancycle 

G81/85 cancycle example：TS16-815.CNC
; G81/85 cancycles in polar system
G92 X0 Y0 Z0
G90 G0 X50.
G2 I-50. J0 F3000.
G0 X100.
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G2 I-100. J0 F3000.
G0 X0 Y0
;
G16
G90 G99 G81 X50. Y0 Z-15. R5. F500.
N1 G91 G81 Y30. Z-10. R5. F500.
M95 P1L10
G15
G90 G0 X0 Y0 Z0
;
G16
G90 G98 G85 X100. Y0 Z-20. R5.F500.
N2 G91 G85 Y20. Z-15. R5. F500.
M95 P2 L16
G15
G90 G0 X0 Y0 Z0
M30

Figure 4-96  An example is illustrated
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G73/G83 example：TS73-83.CNC
; G73 and G83 can cycles in Cartesian system
; Set retract D value=3.0 previously
G92 X0 Y0 Z0
G90 G0 X5. Y5.
G1 X70. F3000.
Y15.
X5.
Y5.
;
G90 G99 G73 X10. Y5. Z-25. Q5. R5. F500.
N1 G91 G73 X10. Z-20. R5. Q5. F500.
M95 P1L4
G90 G0 X70. Y15. Z0
;
G90 G98 G83 X62. Z-25. Q5. R5. F500.
N2 G91 G83 X-10. Z-20. R5. Q5. F500.
M95 P2L4
G90 G0 X0 Y0 Z0
M30
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Figure 4-97  An example is illustrated

4.11.9   the example：G70.00/70.01 pocket 
cutting

SAPG70xx.CNC
;Example program of pocket cutting
;Set No.1 tool radius=6.0  in〝Parameter→Tool table〞
;Set〝Cut in retract length = 1.0 〞in〝Parameter→Cancycle parameters〞previously.
G92 X0 Y0 Z5.0
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D1;select tool No.1
G91
/M03
G70.00 G2 X0 Y0 Z-5. U112. V88. W-13. C1. J0.5 K1. Q4. L10. I100 F1000 E650
G0 X130.
G70.01 G3 X0Y0Z-5. R56. W-13. C1. J0.5 K1. Q4. L10. I100 F1000 E650
G90 G0 X0 Y0 Z5.
/M05
M02 

Figure 4-98  An example is illustrated
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4.11.10   the example: G70.10 Contour Pocket

IR_PKT_1.CNC

;Example program of contour pocket cutting
;Set No.1 tool radius=1.0  in〝Parameter→Tool table〞
;
;main program
G90 D1
G0 X0 Y0 Z5.
G41
M97 P5555
G40
G70.10 G41 P5555 X0 Y0 Z0 W-5. C2. J1. K1. Q2. R3. I500 E700 F1000
G0 Z10.

X0 Y0

M30
;
;Subprogram〔describe contour〕
O5555
G90 G0 X29.5 Y30.9
G1 X45.6
Y37.6
G2 X51.2 R-10.25
G1 Y30.9
X88.
Y42.7
X80.2 Y44.9
G2 Y49.6 R-8.25
G1 X88. Y52.1
Y65.3
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X29.5
Y30.9
M99

Figure 4-99  An example is illustrated
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4.11.11   the example: G70.22 Grid Object 
pattern

OB_GR.CNC：

;Example of Grid Object pattern
;Set No.1 tool radius=1.0  in〝Parameter→Tool table〞
;
;main program
G90 D1
G0 X0 Y0 Z10.
/M97 P5555
G70.22 C0 I70. J50. A3 B2 D10.
@ G70.10 G41 P5555 X70.0 Y-25.0 Z0 W-3. C2. J1. K0 Q3. R3. I500 E700 F1000
G0 Z10.

X0 Y0
M30
;
;Subprogram〔describe contour〕
O5555
G90 G0 X29.5 Y30.9 
G1 X45.6
Y37.6
G2 X51.2 R-10.25
G1 Y30.9
X88.
Y42.7
X80.2 Y44.9
G2 Y49.6 R-8.25
G1 X88. Y52.1
Y65.3
X29.5
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Y30.9 
M99

Figure 4-100  An example is illustrated
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Chapter 5  Optional 
Facility
INCON-ME3 provides optional facilities for users. Users can get desired optional facility 

after finishing business process.

Users can pull down the menu item 〝Help→About INCON-ME3〞and look at the code of 
optional function on the system information screen.

Figure 5-1 The system information

Each of codes of  optional facilities enables by binary rotation 〔1: enable; 0: unable〕, but 
shows by binary hexadecimal, for example, 〝FACILILY: 03〞means ME3 enables 
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Function1 and Function 2.

The optional facility modifies or adds with software maintained.  ME3 provides 6 varied 
optional functions:

0x01：USB Device
0x02：Intek Macro
0x04：High Speed and Precision
0x08：the 4th Axis
0x10：Dual axis drive
0x20： Rigid Tapping of maximum speed up to 1500 rpm

5.1  Facility 0x01 : USB Device
CNC programs usually save as a solid flash memory built in INCON-ME3, and we can also 
transmit CNC programs to controller through FTP.

In addition, INCON- ME3 provides optional facility to transmit CNC programs from USB to 
controller and execute programs in USB.

Pay attention to that most of USB can be read by INCON- ME3 but few of  USB can't be 
done this by its compatibility.

The following conditions are satisfied with using USB:
● The format of USB has to be FAT or FAT32.
● Power supply of USB slot built in INCON- ME3 has limit 〔≤ 0.15 A〕 so that few of 

USB has power supply  in addition.
● The file name must be 〝.CNC〞as its extension name. The file name is not over 8 letters 

which can be English alphabet, number,〝-〞or  〝_〞,for example, TEST_123.CNC is 
a usable file name.

● There are two USB slots in ME3, but the slot used first just can be read.
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Figure 5-2  USB Device Slot

Insert USB to slot, and press〝F2→F→Open...〞to pop a 〝Open a File〞dialog box , as 
below:

Figure 5-3  the 〝Open a File〞dialog box  shows there is USB to select〔press F3 to switch〕

Figure 5-3  shows the files in CNC controller. If the USB Device facility enables, the dialog 
box will appear〝CNC(F3-> )〞
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When you press F3, it will open the CNC files in USB device.

Figure 5-4    Save file in USB device

In the same way, 〝F2→F→Save as...〞,〝F2→F→Delete file...〞also use F3 to switch 
controller and USB device.

5.2   Facility 0x02 : Intek Macro
INTEK MACRO is designed for variable operation to make users program more flexibly. 

The variable can be defined by program assign operation or user parameter. The variable also 
can be set or read by PLC .
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Figure 5-5   the relation between INTEK Macro and outside

There are 1000 variables, arithmetic operator, functional operator, logical operator, and 
conditional operator given on INTEK MACRO. The simplest expression is used under 
INTEK MACRO, so user does not need spend much time to learn program it.

5.2.1   Variable

Variable always starts with a leading code # and follows number. For example, #210 is a 
No.210 variable ; 210 is not a variable.

INTEK MACRO provides 1000 variables from 0 to 999〔#0~#999〕. The numerical data of 
variable can be set by user parameter, program, or PLC.  

● If variable is assigned by program, the expression shall be #3=#4+#5. Variable array 
pointer will transmit to PLC. PLC can set or read variables.  

● When variables are set by user parameter, the dialog box will pop up on screen for setting.
● By using Intek Macro variables, The numerical data of variable in CNC program can be 

replaced by Intek Macro variables, for example:
When #1=500, #2=120, G01 X#2 F#1  is equal to G01 X120 F500
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5.2.2   Arithmetic operator

INTEK MACRO fits for the four fundamental operations of arithmetic. Basic arithmetic 
operators, left and right parenthesis are also used on INTEK MACRO.

+ ；add
- ；subtract
∗ ；multiply
∕ ；divide
( ；left  parenthesis
) ；right parenthesis
= ；assign

Arithmetic operation example:

#3=4 ;#3 to assign as 4
#5=#3+2 ;#5 to assign as 4+2=6
#6=#5+(#3 – 1）;#6 to assign as 6+(4-1）=9

Parenthesis must be a pair on expression otherwise error occurs.

#6=#5/(#7-#8 ;wrong expression
#6=#5/(#7-#8) ;right expression

5.2.3   Functional Operator of  Intek Macro

NTEK MACRO provides built-in functions, such as SIN, SIND, COS, COSD, TAN, 
TAND, ATAN, SQRT, and so on. Furthermore, the one related to trigonometric function 
with〝D〞means its unit is angle; for example, the angle of circle is 360°. The one without 
〝D〞 means its unit is rad.; for example, a circle is about 6.2832 rad.
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Format Definition
SIN SIND sine
COS COSD cosine
TAN TAND tangent
ASIN ASIND arcsine
ACOS ACOSD arccosine
ATAN ATAND arctangent
ABS absolute value

ROUND integer
BROUND round off

SQRT mean square root

Example：

#4=SIN（#3）；
#5=COS（#2+1）；
#7=SQRT（#2+#1）；
#1=TAN（#4）；
#8=ATAN（0.9）；

5.2.4   Logical Operator

INTEK MACRO has logical operation facility; the result of logic operation is〝Zero〞or 
〝None Zero〞. The logical operation usually combines with conditional expression or loop.
Expressions of logical operation are listed as below:

== ;equal  
!= ;not equal 
>= ;large equal  
<= ;small equal
> ;large
< ;small
& ;intersection, and
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¦ ;union、or 
! ;not

Example 1：

#3=8;
#4=9;
#7=(#3==#4);
The value of #7 is〝 Zero〞.

#3=7;
#4=7;
#7=(#3==#4);
The value of #7 is〝 None Zero〞

Example 2：

#251=20;
#252=21;
#100=(#251!=#252);
The value of #100 is〝 None Zero〞

Example 3：

#250=10;
#253=4;
#252=8;
#100=9;
#121=0;
#120=1;
#40=((#250-#253)>#252)&(#100>=(#121+#120));
The value of #40 is〝 Zero〞.
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5.2.5   Condition and Program Flow

INTEK MACRO has three loops for condition and program flow: IF, IF... ELSE and 
WHILE.

5.2.5.1    IF

Format：

IF variable  P end line number

Example：

IF #100 P100;
G00 X#3 Y100;
G01 X100 Y#2 F#8;
N100 G53 X0 Z0;
G01 X300 F0.1;
M30;

The value of #100 is〝 None Zero〞, program will execute as below:

G00 X#3 Y100;
G01 X100 Y#2 F#8;
N100 G53 X0 Y0;
G01 X300 F0.1;
M30;

If variable #100 is〝 Zero〞, program will be executed as below:

G01 X300 F0.1;
M30;
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5.2.5.2     IF ...  ELSE

Format:

 IF  variable  P end line number A
N end line number A
ELSE  P end line number B
 N end line number B

Example:

IF #1 P100
G00 X800 Y1000;
G01 X1000 Y200 Z-10;
N100 G00 X0 Y0 Z0
ELSE P200
G00 X1600 Y1000;
G01 X1800 Y200 Z-10;
N200 G00 X0 Y0 Z0;
M30;

The value of #1 is〝 None Zero〞, program will execute as below:

G00 X800 Y1000;
G01 X1000 Y200 Z-10;
G00 X0 Y0 Z0;
M30;

The value of #1 is〝Zero〞, program will execute as below:

G00 X1600 Y1000
G01 X1800 Y200 Z-10;
G00 X0 Y0 Z0;
M30;
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5.2.5.3    WHILE

Format:

WHILE  variable  P end line number

Example:

#7=4;
WHILE #7 P80
G90 G01 Z-10 F0.8;
G91 G01 X100 F1.0;
#7=#7-1;
N80 G90 G01 Z0 F0.8;

Program will execute as below:

G90 G01 Z-10 F0.8;
G91 G01 X100 F1.0;
G90 G01 Z0 F0.8;
G90 G01 Z-10 F0.8;
G91 G01 X100 F1.0;
G90 G01 Z0 F0.8;
G90 G01 Z-10 F0.8;
G91 G01 X100 F1.0;
G90 G01 Z0 F0.8;
G90 G01 Z-10 F0.8;
G91 G01 X100 F1.0;
G90 G01 Z0 F0.8;
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5.2.6    High Speed Macro

G10.60：High  Speed Macro enable
G11.60：High  Speed Macro disable

5.2.7   Macro application example

Pocket Circular : 

Figure 5-6   Pocket Circular

Radius of pocket is assigned by users on account of variable. Radius of tool is also assigned 
by users on account of variable. Flowchart is as below:
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Figure 5-7   Flowchart of pocket circular

Pocket Circular Program:

#2=0;
#3=#1-#0;
#2=#0+#2;
#4=#3>#2;
WHILE #4 P10;
G01 X#2 Y0 F400;
G02 I-#2 J0 F400;
#2=#2+#0;
N10 #4=#3>#2;
G01 X#3 Y0 F400;
G02 I-#3 J0 F400;
M30;
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5.3   Facility 0x04 : High Speed 
and High Precision
When INCON-ME3 provides optional facility: high speed and high precision cutting, the 
parameters about high speed and high precision cutting enable. 

5.4   Facility 0x08 : the 4th Axis
When this optional facility is selected, INCON-ME3 has the 4th Axis.

5.5   Facility 0x10 : Dual Axis drive
When this optional facility is selected, the 4th axis is treated as a teamwork follow axis and 
move with the followed axis at the same time.

5.6   Facility 0x20 : Rigid Tapping 
When this optional facility is selected, ME3 can execute rigid tapping of maximum speed up 
to 1500 rpm.
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